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Voyager Graphic User Interface

This section describes the Voyager Graphic User Interface in a hierarchical, ‘top-down’
manner.   

Using the Keyboard and the Mouse
To move Mix Icons around the Mix Forms, use a <left click, drag, and release> on the
icon to be moved. A single <left click> on an icon causes it to be selected. A selected
Mix Icon is drawn with a red square surrounding it.

If the <space bar> on the keyboard is typed when a Mix Icon is selected, ‘Mouse Lock’
Mode is entered. The Mix Icon will be attached to any movement of the mouse without
having to hold down the left mouse button. Another <space bar> toggles this mode off.

The keyboard cursor keys, up, left, right, and down, will move the selected Mix Icon in
the appropriate direction. If the Mix Icon is on a rectangular Mix Form, then the icon
moves up, down, left and right. If the Mix Icon is on a radial Mix Form, then the icon
moves in and out in radius, and left and right in angular position. If the <control> key is
held down when the arrow keys are pressed, the Mix Icon moves in larger increments.

A <control-C> typed on the keyboard (or if copy is selected from the Edit menu) copies
the selected Mix Icon to the Windows clipboard. If no icon is selected then the selected
Mix Form is copied to the clipboard. A <control-X> ‘cuts’ the selected icon or Mix
Form and a <control-V> ‘pastes’ the contents of the Windows clipboard to the selected
Mix Form or Mix Frame. These actions can also be selected from the Edit menu.



7

A selected Mix Form has the title bar drawn in blue. Any click on or within the Mix
Form boundary will select that Mix Form (provided some other Mix Form isn’t in the
way).

To move a Mix Form, <left click and drag> on the Mix Form’s title bar. To resize a Mix
Form, <left click and drag> on a corner or a side of the Mix Form. The cursor will
change to a double-arrowed symbol when it is over a ‘resize’ point.

A <right-click> on Mix Forms or Mix Icons brings up the appropriate context menus. If
GraphiMix is set to Build Mode, extra entries appear in these context menus. GraphiMix
is toggled between Run Mode and Build Mode by toggling the Run/Build Mode button
on the standard toolbar.

Standard Toolbar

Run Mode Build Mode

This is a Mix Icon context menu.

‘Run’ mode ‘Build’ mode
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This is a Mix Form context menu.

‘Run’ mode ‘Build’ mode

Mix Form and Mix Icon properties are displayed and modified by the selection of the
Properties entry.

The <shift> and <control> keys modify the operation of the Mouse buttons.

A <shift-left click> toggles the Mix Icon in and out of ‘Solo’
mode. A Mix Icon in Solo Mode is drawn with a bright green halo.
MIDI messages can be sent when the icon enters or leaves solo
mode.

Solo mode typically ‘solos’ the track or bus so that it can be heard
by itself, temporarily removing all other ‘non-soloed’ tracks from
the mix.
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A <shift-right click> toggles the Mix Icon in and out of ‘Mute’
mode. A Mix Icon in Mute Mode is drawn semi-transparently and
dim. MIDI messages can be sent when the icon enters or leaves
mute mode.

Mute mode typically ‘mutes’ the track or bus, temporarily
removing its contribution to the mix or monitors.

A <control-left click> is used to adjust the setting of a knob, fader or list control. If the
<control> key is not held down, the control’s position on the Mix Form is moved (via a
normal <left click and drag> operation). However, if the <control> key is held down, the
<left click and drag> operation is applied instead to the rotation of the knob or the
movement of the slider or the list entry selection.

A <control-left click> on a switch toggles the state of
the switch.

Knobs, faders, and switch Mix Icons can be optionally set so that their position is fixed.
In this mode, the <control> key is not needed to adjust their fader, knob, or switch
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positions when dragging. All switches used in the templates are set this way so that
the user can simply <left-click> on the switch or icon to change its state.

The <mouse wheel> is also used in GraphiMix.  If a Mix Icon is selected, the <mouse
wheel> moves the icon according to the Mix Icon movement constraints (set in its
properties dialog) and what kind of Mix Form it is placed on. If the Mix Icon is placed on
a stereo Mix Form (semi-circle), then the <mouse wheel> moves the selected icon in a
radial direction. On a normal Mix Icon with pan and volume controls, this would equate
to moving just the volume control with the wheel. A <Shift-mouse wheel> would move
the icon in an angular direction, i.e. adjust only the Pan control. If the control is placed on
a rectangular Mix Form, then the <mouse wheel> moves the icon in the Y direction (up
and down) and the <shift-mouse wheel> moves the icon in the X direction (side to side).
This provides a vernier-type of control which is useful in making small precise
adjustments.

A <control-mouse wheel> adjusts the Radius Mapping settings
for the selected Mix Icon. The Radius mapping setting allows the
user to provide more adjustment resolution near the high end or
the low end of the adjustment range as opposed to a strictly linear
mapping which provides constant resolution throughout the Mix
Icon range.

The <Delete> key will delete the selected object such as Mix Icons, Mix Forms, and
Links only if GraphiMix is in ‘Build’ mode.

Keyboard and Mouse Summary

Keyboard:

UP, DOWN, LEFT, RIGHT Move selected Mix Icon
accordingly.

UP, DOWN, LEFT, RIGHT
+<Control>

Move selected Mix Icon
accordingly with larger steps

<Control-C> Copy the selected Mix Icon or the
selected Mix Form to the
clipboard.

<Control-X> Cut the selected Mix Icon or the
selected Mix Form to the
clipboard.
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<Control-V> Paste from the clipboard.

SPACE Toggle ‘Mouse Lock Mode’ for
the selected Mix Icon.

DELETE Delete the selected object. Build
mode must be enabled in order to
use this key.

+,- Zoom in/out selected Mix Form.

Mouse:

Keyboard <Left Click> <Mouse Wheel> <Right Click>

-none- Select Mix Icon or
Mix Form.
Drag Mix Icon or
Mix Form.

Adjust Radius on
Stereo/Quad Mix
Form.
Adjust Y on
Rectangular Mix
Forms.

Context Menu for
Mix Icon or Mix
Form.

<Shift> Toggle Mix Icon in
Solo Mode.

Adjust Angle on
Stereo/Quad Mix
Form.
Adjust X on
Rectangular Mix
Forms.

Toggle Mix Icon in
Mute Mode.

<Control> Toggle Switch Mix
Icon.
Drag Knob and
Fader settings.

Adjust Radius
Mapping for Mix
Icon.

Context Menu for
Mix Icon or Mix
Form.

Mix Frame
The Mix Frame is the outermost window of the Voyager Mix System. The Mix Frame
contains all of the Mix Forms that are active in a GraphiMix session. Mix tool bars, Icon
bars, and tab bars can attach to the Mix Frame or be dragged free. The Main menus are
contained on the Mix Frame.

The Mix Frame window can be expanded to fit the screen, shrunk to a normal, resizable
window, or minimized to an icon on the Windows Tool bar.
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Mix Forms can be ‘tiled’ in ‘Always Stay Tiled’ mode. These Mix Forms will then
completely tile the Mix Frame window. They will automatically readjust when the Mix
Frame is resized, or when individual tiled Mix Forms have their size changed.

This is an example showing a Mix Frame containing a blank Stereo Mix Form and 3
attached Toolbars.
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Mix Forms and Mix Form Coordinates

Mix Forms represent the ‘work surface’ for a collection of sound sources  represented by
Mix Icons, which are to be mixed together. A GraphiMix session, stored in a VOY file,
may incorporate several different Mix Forms, each representing a ‘sub-mix’ mapped into
some arbitrary set of mix hardware.

A Mix Form is created by first selecting Insert Menu->New Mix Form or by using the
Mix Form Tool Bar.
There are four different types of Mix Forms, Stereo, Stereo Rectangular, Surround and
Surround Rectangular. These are selected in the Mix Form Properties dialog.  Mix Form
Properties can be selected by a right mouse click on the Mix Form if GraphiMix is in
‘Build’ mode. For more information on ‘Build’ mode see Using the Keyboard and the
Mouse, page 6.

A Mix Form can be ‘shrunk to an icon’, ‘expanded to full screen’, or ‘hidden’ by using
the 3 buttons at the upper right corner of each Mix Form.
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When a Mix Form is ‘hidden’, it is removed from view but is not deleted.  To hide a Mix
Form, <right-click> on a Mix Form and select ‘Hide Mix Form’, or <left-click> on the
‘X’ button at the upper right of each Mix Form.  One of several ways to re-show a
‘hidden’ Mix Form is to select the ‘View Menu->Show All Hidden Mix Forms’ entry.
This feature is useful in removing visual clutter by showing only the Mix Forms that are
actively in use. All other Mix Forms (Mix Forms for EQ for every channel for example)
can be hidden until needed.

To delete a Mix Form, GraphiMix must be in ‘Build’ mode. First, select the Mix Form to
be deleted (Mix Form title will show in blue) and then type the <Delete> key on the
keyboard. Alternatively, you can use the Edit Menu to delete the selected Mix Form.

GraphiMix allows a Mix Form to be ‘linked’ to an Icon. Right-clicking on a Mix Icon
then allows the user to select a Mix Form that is linked to that Icon. In this way, a Mix
Form can be created to hold EQ or effects controls for a particular channel and then be
‘hidden’. The hidden Mix Form can then be un-hidden by right-clicking on the linked
Mix Icon and selecting it. Note that the ‘Linked Mix Form’ can be used with any
controls, just like a normal Mix Form.

GraphiMix includes a feature called ‘Mix Form Groups’. Each Mix Form can be a
member of one of any number of named Mix Form Groups. Mix Form Group Mode is
entered by depressing the Mix Form Group Mode button on the standard toolbar. For
more information on Mix Form Groups, see Mix Form Groups, page 36.

Standard Toolbar

Mix Form
Groups Off

Mix Form
Groups On

All Mix Forms have a Mix Form Origin. If the Mix Form is a Stereo or a Stereo
Rectangular Mix Form, the Origin is at the bottom center of the Mix Form. If the Mix
Form is a Surround or Surround Rectangular type, the Mix Form Origin is at the Center
of the Mix Form.

When a Mix Icon is placed on the Mix Form, the Mix Icon will have defined Mix Form
Coordinates relative to the origin. These coordinates include Radius, Theta, X, and Y.
The Radius coordinates range from 0 (at the origin) to 100% (at the radius boundary).
The X and Y coordinates range from -100% to +100%, with 0 being at the origin. The
Theta coordinates range from -180 to +180 degrees with 0 degrees indicating the front
and 180 degrees indicating the rear.

Inverse versions of these Mix Form Coordinates are also supplied. The Inverse Radius
coordinate, for example, will range from 100% at the Mix Form Origin to 0 at the radius
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boundary. A typical fader control could be attached to the Inverse Radius coordinate to
be ‘loudest’ at the Mix Form Origin and muted at the radius boundary.

A Complex Mix Icon such as a knob, fader, switch, or indexed list, adds additional
coordinates, such as Fader and Inverse Fader, or ListIndex, to the available Mix Form
Coordinates.

The view of a Mix Form can be ‘zoomed’ and ‘un-zoomed’ with the ‘+’ and  ‘-‘ keys
respectively. The modes are also selectable from the View menu.

Mix Form Properties
This dialog is selected by right-clicking on the Mix Form background and selecting
‘Properties’ when GraphiMix is in ‘Build’ mode.
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Geometry

The Mix Form Properties Geometry dialog selects which Mix Form Geometry is applied.

The Stereo Mix Form types are essentially ‘half-plane’ geometry, where X ranges from -
100% to +100% but Y ranges from 0% to +100%. The Mix Form Origin is at the bottom
center.

Surround Mix Form types use ‘full-plane’ geometry where both X and Y range from -
100% to +100%. The Mix Form Origin is at the center of the Mix Form.

The ‘Rectangular’ Mix Form types only affect how a Mix Form ‘looks’ and does not
affect the underlying coordinates that are always available.

The Mix Form name can be changed and entered in the Name field.

Midi can be disabled for all Mix Icons on the selected Mix Form by un-checking the
Enable Midi checkbox.
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An individual Mix Form can be prevented from being hidden if the ‘Allow To Be
Hidden’ checkbox is un-checked. This is useful to prevent the top-level Mix Form (which
is usually linked to many subordinate hidden Mix Forms) from being hidden itself.

Check boxes to Allow Small/Medium/Large Icons are provided. The Mix Icons will
change their size dynamically as the Mix Form size is changed. There are 3 sizes
provided for each Mix Icon Image. Some of these choices may be disallowed dependent
on user preferences. For example to force small icons on a large Mix Form, deselect the
Allow Medium and Allow Large Icon checkboxes. A slider is provided on this dialog that
allows the user to set the automatic thresholds for changing the icon sizes to suit
individual preferences.

Stereo Mix Form
On a Stereo Mix Form the range of X is +/- 100%, and the range of Y is 0->100%. The
green boundary indicates the perimeter where the radius coordinates reach their limits.
Radius ranges from 0 at the flat radius to 100% at the radius boundary. Theta ranges from
-90 to +90 degrees.

A Stereo Mix Form can be used for the typical fader-pan pot type of control. In this
arrangement, a Mix Icon typically has at least two controls attached, a fader and a pan
pot. The fader is usually ‘attached to’ the Inverse Radius Coordinate so that it is loudest
at the Mix Form Origin, and the pan pot control is usually attached to the Theta
Coordinate.

The effective Minimum radius of the Mix Icon is set by the Mix Form’s Flat Radius (see,
Radius Mapping, page 34 ) and the Maximum radius is shown on the corresponding Mix
Form.

The MIDI value output to the corresponding control ranges from the Minimum (set in the
Mix Icons’ Control Tab) at the Flat Radius to the Maximum (also set in the Mix Icons’
Control Tab) shown on the Mix Form. The value actually output to the control depends
on its position on the Mix Form, the value of the Flat Radius, and the setting of the
Mapped Radius for the corresponding Mix Icon.

If the Inverse Radius coordinate is used for volume then the Inverse Radius component
goes to 0 at the radius boundary. If a Mix Icon is placed beyond the boundary in the Mix
Form Mute Region, the output value will remain at 0. Icons that are not currently active
can be ‘parked’ in this region until needed and they will remain muted.
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In this case, this radius boundary is referred to as the Mix Form Mute Boundary. The
region inside the Mix Form Radius including the Mix Form Origin is the Mix Form
Active Region. The Mix Form Mute Region is the region outside the active region.
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Stereo Rectangular Mix Form
A Stereo Rectangular Mix Form can be used for other types of controls, where X and Y
might be a better choice for the graphic format of the desired controls. The range of X is
+/- 100%, and the range of Y is 0->100% on this form. The green boundary indicates the
perimeter where the X and Y components reach their limits.
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Surround Mix Form
A Surround Mix Form is useful for creating surround-type mixes where a fader and a
surround panner would be attached to the Mix Icon.

For a Surround Mix Form the range of X is +/- 100%, and the range of Y is -100%-
>100%. The green boundary indicates the perimeter where the radius coordinate reaches
its limit.

The Mix Form mapping using the Inverse Radius coordinate for volume level is shown.
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Surround Rectangular Mix Form
A Surround Rectangular mirrors the same coordinate system as the Surround Mix Form
but is more useful for non-(fader, surround pan pot) controls.
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Backgrounds

GraphiMix allows considerable customization of each Mix Form background. The
background page of the Mix Form dialog box is shown above.  The ‘Set Background
Color’ button allows a selection of background colors.  Black is the default background
color.

Mix Form Background Images

The ‘Background Image button’ allows the user to specify a windows bitmap (BMP)
image to fill the Mix Form background instead of a single color.
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Control and Coordinate regions

The ‘Show Control Regions’ checkbox allows the user to specify whether control regions
are drawn over the Mix Form background.
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The  ‘Show Coord Regions’ checkbox allows the user to specify whether the Coordinate
regions are drawn over the Mix Form background.

The Coordinate regions are the outer semicircle for stereo Mix Forms, the outer circle for
the Surround Mix Forms, with the Mix Form Origin. The Coordinate region for
rectangular Mix Forms is the outer rectangle.

The ‘Use Defaults’ button removes all customization for this mix form and reverts the
mix form to factory settings.
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The ‘Show Control Regions’ check box determines whether or not control regions will be
displayed.  Control regions are described below.

Grids
Grids allow the user to visually calibrate a mix icon position to a particular MIDI device.

You may choose to have a horizontal grid or a vertical grid or both.  For each grid, you
specify the number of grid lines and the color and width of those grid lines.  The linearity
combo box allows you to specify either a linear grid, or one of several logarithmic or
inverse logarithmic grid spacings.  When using logarithmic or inverse logarithmic
spacing, the number of grid lines specified is taken to mean the number of grid lines per
decade.  Grid lines may be rectangular or circular. Normally rectangular grids are used on
rectangular mix forms and circular grids are used on circular mix forms, but there is no
restriction.

Finally, each grid may be shifted by a given positive or negative percentage amount or
expanded by a given positive of negative percentage amount in order to produce grids
that line up exactly with user expectations for a given piece of equipment. Fractional
percentage amounts such as 2.3 may be entered into any percentage field. As each change
is made to the grid specification, the corresponding grid is immediately drawn in the
selected mix form background. Move the dialog box if necessary to allow the mix form to
be seen.
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The mix form background shown above has 10 linearly spaced horizontal lines and 20
logarithmically spaced vertical grid lines per decade, with two logarithmic decades.
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This mix form shows 10 radial grid lines and 20 angular grid lines.

Axes
An axis is a single line which may have any number of tick marks.  A mix form may have
any number of axes.  To add an axis, click the ‘Add Axis’ button.  To delete an axis, click
the ‘Del Axis’ button.  To select a particular axis, use the axis tab bar as shown below.
The ‘Add Axis’ button always adds an axis to end of the list of axes.  The ‘Del Axis’
button always deletes the currently selected axis.

An axis can be copied to the clipboard and ‘pasted’ to another Mix Form.

In the GraphiMix Pro version, Axes may also be used as calibration objects for controls
to enable accurate Dynamic Status Displays that indicate the actual settings of the target
hardware. See Mix Icons, Dynamic Status, page 68, for more information.
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The axis style may be vertical, horizontal, radial, or circular, and is selected via the axis
style combo box.  The ‘Color’ button allows the axis color to be specified. Each axis has
a start percent and an end percent value. These specify the starting and ending position of
the axis in terms of the range over which MIDI is normally active on the mix form.
However you may force the axis to start or end outside of this range by entering values
outside of the range from 0 to 100.  For example, an axis may start at -5.6% or end at
120%.  The offset box specifies the position of the axis in the direction perpendicular to
its length, again in terms of a percentage of allowable range.

The axis has a name. This name can be used to specify this axis as a calibration object for
a particular control for a particular Mix Icon.

The axis may be visible or invisible. If an axis is used to specify a particular calibration
for a particular control using dynamic status displays, it may be desirable to inhibit the
actual display of the axis. In this case, the ‘Visible’ checkbox can be unchecked.

An axis can have its units specified such as ‘dB’, ‘Hz’, etc.
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If multiple axes are available on this Mix Form, it may be difficult to discern which axis
is being modified. The ‘Blink Axis’ button blinks the corresponding axis on the Mix
Form for identification.

Tick Marks
Tick marks allow calibration marks to be placed on axes.  Each axis may have any
number of tick marks.  To add a tick mark, use the ‘Add Tick’ button. To delete a tick
mark, use the ‘Del Tick’ button.  To navigate among the tick marks for a particular axis,
first use the axis tab bar to select the appropriate axis. Then use the tick tab bar to select
the desired tick mark. The ‘Add Tick’ button always adds a tick mark to end of the list of
tick marks.  The ‘Del Tick’ button always deletes the currently selected tick mark.

Tick marks may be placed linearly along the axis, or they may be spaced logarithmically
or inverse logarithmically in any of several styles of decades.  By clicking the ‘Manual
Tick Placement’ box, the tick marks may be manually placed at any arbitrary desired
position.
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Tick marks have a width, a color, a length, and an offset. The offset percent is in the
direction perpendicular to the associated axis. The offset percentage may be positive or
negative.

An optional caption can be shown next to each tick mark.  The caption standoff
percentage is adjustable as well as the caption font and color.
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The above example shows a radial axis in red with 7 linearly spaced tick marks, each
with a blue caption.

Each tick mark has an associated Calibration Value which is used to provide calibrated
Dynamic displays for individual Mix Icons and their attached controls. These Calibration
Values can be set individually for each tick mark or may be automatically generated
based on each tick mark’s position along the axis. To set them automatically, set the Start
and End values in the Calibration Auto Computation box, and then click Auto Compute.
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Tags
When two identical mix icons are added to the same Mix Form (although they may be
attached to different controls), tags may be optionally added to the icon image at the
bottom right corner in order to visually distinguish between them. These Mix Icon Tags
are automatically selected from a particular sequence which can be set by the user by
clicking on a particular line of Tags in the Tag Display.

To add tags automatically, select the Tag Enable checkbox.

Tags can be displayed double size. To enable this select the Display Double Size
checkbox.
To remove the selected tag sequence completely, click the Deassign button. This has the
same effect as deselecting the Tag Enable checkbox.
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Here is an example of identical icons with Tags attached.

Control Regions
Control Regions are intended to be user definable regions where the use can define
custom coordinates. These coordinates can be non-linear mappings of the underlying
coordinate (such as Radius) or can be completely independent. This would allow the user
to customize the response of any particular control or set of controls when in this region.
These regions are drawn on the Mix Form in light green to give a visual indication of the
location of these regions.

For example, a crescent-shaped region could be implemented in the Stereo Mix Form that
was next to the Radius Boundary that could be an Accelerated Fade Out region. Instead
of the control’s value being strictly proportional to the Radial distance from the Mix
Origin, The values could ‘accelerate toward fadeout’ when the Icon was in this region.
This would allow a tradeoff between coarser control at the lowest volume settings of the
fader (when the Mix Icon was in this control region), for finer control at the higher
volume settings (when the Mix Icon is in the central region of the Mix Form).

This can be very useful in mapping EQ settings to a particular area of a Stereo Mix form
for automatic effects changes with Icon position.
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At this point in GraphiMix development, control regions only draw, and there is no
provision yet for defining custom coordinates to be used by controls attached to Mix
Icons.

Radius Mapping

Radius Mapping is a mapping from the physical radius of a mix icon (on the Mix Form)
to the value that is converted into MIDI.  The mapping may be linear or non-linear.
Radius mapping allows the user to make better use of the available space on a mix form
and to match the characteristics of hardware devices.  For example, there may not be
enough room near the center of the mix form to conveniently place all of the mix icons
that need to be near the center.  In this case, the radius mapping mechanism can allow the
user to effectively expand the center region to make more room.
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The horizontal axis in this graph shows the Mix Icon radius as shown on the Mix Form.
The vertical axis represents the output value sent to the control. Note that at the left side
of the graph, there is a ‘flat’ area where the output value is zero, yet the icon has a small
radius. If ‘inverse radius’ is used as the control coordinate this icon radius would
represent a control maximum value, i.e. the vertical axis would be inverted.

There are two parts to the radius mapping. The first part is the ‘flat radius’ value.  The
flat radius value allows the user to specify a radius, in percent, over which the
corresponding control value will be constant and ‘flat’ (a maximum or a minimum).  All
radii with a value less than or equal to the flat radius will use a mapped radius of 0 when
computing MIDI input or output. Each mix form has a single value of the flat radius
value.  All mix icons on the same mix form share the same flat radius value.  When the
flat radius is changed for one mix icon, it changes automatically for all mix icons on the
same mix form.

The second part of the radius mapping is the ‘radius mapping value’.  The radius
mapping value changes the shape of the mapping curve.  When the radius mapping value
is small, then the slope of the mapping curve will be small at small radii and large at large
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radii.  When the radius mapping value is large, then the slope of the mapping curve will
be large at small radii and small at large radii. When the radius mapping value is set to 50
percent, the mapping is linear, i.e. has a constant slope throughout.

The radius mapping value may also be changed by using a <control-mouse wheel> action
on a selected Mix Icon. This results in a small image of the mapping being shown at the
cursor position. In this case the flat radius value is not changed.

The radius mapping attributes may be modified in a total of four different ways:

Action Flat Radius Value Radius Mapping Value
Right Click On Mix Icon,
select Properties, then select
Radius Mapping Tab

Changes flat radius for all
mix icons on the mix form.

Changes radius mapping for
this mix icon only

Right Click On Mix Form,
select Properties, then select
Radius Mapping Tab

Changes flat radius for all
mix icons on the mix form

Changes the default radius
mapping used by new mix
icons

The Edit Preferences Menu
(Select Radius Mapping
Tab)

Changes the default flat
radius used by new mix
forms

Changes the default radius
mapping used by new mix
forms.

Control-Mouse wheel No Change Changes radius mapping for
this mix icon only

Mix Form Groups
Mix Form Groups were created to allow GraphiMix to automatically display related
controls, for example, the EQ and Aux Sends, when a Mix Icon is selected.

The Mix Form Group feature allows the engineer to assign each Mix Form to a specific,
named group. When GraphiMix is in Mix Form Group Mode, all Mix Forms which are a
member of the same 'Mix Form Group’ will appear at one size and location on the screen.

Additionally, any Mix Icon that is selected and is linked to a Mix Form that belongs to a
group will cause that icon’s Mix Form to be displayed, and the previously visible Mix
Form (linked to a different icon) will be automatically hidden.
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Standard Toolbar

Mix Form
Groups Off

Mix Form
Groups On

For example, if the EQ Mix Form for channel 1 is made visible by selecting it on the Mix
Icon's context menu, it will show the EQ settings for that channel. Then, if the engineer
subsequently clicks on the Channel 2 Mix Icon, the EQ Mix Form for channel 2 will
automatically replace the one for channel 1, showing at the same size and location.

Channel 1’s Control and EQ forms are shown in Mix Form Group Mode. Each form is a
member of a separate Mix Form Group.
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Now, channel 2’s Mix Icon is selected. The respective Controls and EQ Mix Forms are
automatically displayed at the same position and size as the previous channel’s Mix
Forms.
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Each Mix Form Group can be assigned a color. When in Mix Form Group Mode, Mix
Forms will display this color as a colored box around the outside of the selected Mix
Form, indicating that GraphiMix is in this mode and that the selected Mix Form is a
member of a specific Mix Form Group.
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Mix Icons and Controls
A Mix Icon typically represents a single source of sound or a collection of controls to be
changed together to affect a single source of sound.

Examples of Mix Icons are:

Normal Mix Icons (included with the
GraphiMix) as instruments.

A custom text-based icon. Note that the
background can be made transparent.

Three text-based icons. Foreground and
background colors are selectable.

A switch icon. These can be used as normal
Mix Icons and additionally add two
coordinates (SwitchToOn and
SwitchToOff)  to the Mix Icon Coordinates
available to a control.

Another switch icon. These can be
customized by user-supplied BMP files for
each switch state.

Another switch icon. A switch icon doesn’t
have to look like a switch.



41

A vertical fader icon. These can be
customized to suit almost any ‘look’. These
also can be used as normal Mix Icons and
additionally add 2 new coordinates (Fader
and InverseFader) to the list of Mix Icon
Coordinates available to a control.

Another variant of a vertical fader.

An example of a horizontal fader.

A knob fader. This can be highly
customized. A knob fader supports optional
‘tick labels’.

An Indexed List Icon. This icon displays a
text string that corresponds to the value
received or sent. This text string is
contained in a file of text strings which
represent all possible values for this
control. A typical use for this type would
be to set a router or to simulate a multi-
position switch.

A Mix Icon can represent an individual instrument on a MIDI composition or an input on
a hardware mixer. An individual Mix Icon can have multiple audio controls attached to it.
Each audio control would affect some parameter of the particular sound source or input
channel. These controls can be faders, pan-pots, equalization controls, reverb controls, or
anything that can be controlled by sending commands to it. It could even be a lighting
controller used in a live venue.
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When a Mix Icon is placed on a Mix Form it will have Mix Form Coordinates defined
which characterize where the icon is placed relative to the Mix Form.

Any individual control can be ‘attached’ to a particular Mix Form Coordinate.  These
coordinates are translated by a Data Type method and the MIN and MAX settings, and
any Radius Mapping settings, to the hardware control value. This value is then sent to the
actual audio control with a message protocol that is defined by the selected GraphiMix
VSL file.

This allows for extremely flexible configuration and control of arbitrary MIDI
compatible hardware. A Mix Icon is placed on a Mix Form by first selecting the View
Menu->View Icon Windows…  menu entry. This brings up the VLB Windows dialog
which contains a list of Mix Icon Directories. By selecting one or more of these
directories, windows will appear which contains libraries of predefined icon images.
Select an icon by depressing the left mouse button and drag it to the Mix Form. Release
the left mouse button. This copies the selected icon to the selected Mix Form. An
alternative way is to use the Insert Menu->New Mix Icon path.

Mix Icons can be moved between VLB windows by dragging and dropping them. New
VLB directories can be created by right-clicking on the VLB Windows dialog. Once
created, a VLB directory can be renamed or deleted by right-clicking on the selected
VLB directory.

To select the Mix Icon Properties right-click on the selected Mix Icon. See Mix Icon
Properties, page 54, for more information.

Moving Mix Icons within the Mix Form
The Mix Icon can be moved around the Mix Form in various ways. The most direct way
is to ‘click and drag’ the Mix Icon with the mouse. When a Mix Icon is selected, it is
outlined with a red square. A selected Mix Icon will also receive commands from the
keyboard.

When clicking and dragging with a mouse, the ‘feel’ of  the Mix Icon movement can be
adjusted, on a per Icon basis, in the Mix Icon Properties tab. This tab contains a slider bar
for ‘Mouse Smoothing During Drag Operations’.  This allows the Mix Icon’s
responsiveness to be adjusted from 'quick and responsive' to 'slow and smooth'. See Mix
Icon Properties, page 54, for more information.

The ‘up’ and ‘down’ arrow keys will move the selected icon in a radial direction if the
Icon’s movement is unconstrained (set in the Mix Icon Properties tab) or in a linear
direction if the icon is in ConstantX or ConstantY mode.
The ‘left’ and ‘right’ arrow keys move the icon in an angular direction if the Icon is
unconstrained or in a linear direction if in ConstantX or ConstantY mode.
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If the space bar is typed when an icon is selected, the Mix Icon enters ‘Mouse Lock
Mode’. This ‘attaches’ the Mix Icon to the mouse without having to click and drag. In
this mode, any movement of the mouse is reflected in movement of the selected Mix
Icon. To ‘release’ the Mix Icon and leave ‘Mouse Lock Mode’, type the spacebar again.

On a stereo or surround mix form, the mouse wheel will cause the selected unconstrained
mix icon to move along its radius.  A <shift>-mouse wheel will move the selected
unconstrained mix icon along its theta direction.  On a rectangular mix form the mouse
wheel moves an unconstrained mix icon in the y direction while a shift mouse wheel
moves the icon in the x direction. If the icon has constraints then the movement of the
icon will be modified by those constraints.

A <control>-mouse wheel changes the mix icon’s radius mapping property. Radius
mapping is described in a separate section of the user’s manual.

Received messages can also cause the Mix Icon to move. If the Mix Icon has been moved
by ‘Internal’ commands (mouse, keyboard) then it will ignore any commands coming
from ‘External’ sources (i.e. MIDI) for a short time after the last Mix Icon move. This
time is set by the Control Change Source Standoff Timer (CCSST) in the Edit-
>Preferences Menu.

Not all received messages will produce Mix Icon movement. Mix Icons only respond to
MIDI messages if the Control Data Type is set to ‘Fader’, ‘PanPot’, or ‘Surround
PanPot’.

The internal state of a Mix Icon can be changed by holding down the <Control> key
when clicking on the Mix Icon. For example, a <control-click> on a Switch icon, toggles
the switch state On or Off. By holding down the <control> key and clicking and dragging
the ‘knob’ or ‘fader’ handle, one can change the setting of the knob or fader without
moving the icon on the Mix Form.

If the checkbox entitled ‘Left Click Adjusts Fader Value’ is checked in the Mix Icon
Properties dialog, then the states described above are accessed without the use of the
<control> key. For example, if this mode is set, a switch will toggle with a simple left
click instead of a <control-left click>. A simple <left click-and-drag> will change the
knob or fader value, instead of adjusting the position of the control on the Mix Form.

A <shift-left click> on a Mix Icon toggles the ‘Solo’ state on and off. A <shift-right
click> on a Mix Icon toggles the ‘Mute’ state on and off. Controls could be attached to
these states to switch a channel on a mixer to a ‘Solo’ or ‘Mute’ setting. The Mute and
Solo states can also be accessed by using the Mix Icon’s context menu (<right-click> on
the Mix Icon).

Mix Icon Linking
Mix Icons can be linked together. This provides the ability to ‘gang’ controls together,
only in a much more flexible way than conventional consoles. When icons are linked, the
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position of a Master Icon controls the positions of one or more Slave Icons. There are
many different kinds of links that control how the Slave Icon moves with respect to the
Master Icon.

To link a Master Icon to a Slave Icon, first click on the Link Button on the Mix Form
Tool Bar. If the tool bar is not currently shown, click on the View menu->View Mix
Form Tool Bar entry first.

After selecting Linking Mode, the cursor changes to a ‘chain-link’ cursor. Click on the
desired ‘Master’ Mix Icon and then click on the desired ‘Slave’ Mix Icon.

At this point, the link properties dialog will appear, prompting the user to choose the
appropriate link type. Select the link type and properties and then click ‘OK’.

A link has now been created between the Master and the Slave Mix Icons. To view and
change the link properties, right-click on the drawn link. In order to see the created link,
select the View Menu->View Links selections. The engineer can select all links to be
drawn or only the links attached to the Master Mix Icon in the Options Menu->Link
Options dialog.

The Master and Slave Mix Icons can be on different Mix Forms. Links can also be
circular in the sense that a Master Mix Icon can also be a Slave at the same time. The
only restriction is that a Mix Icon cannot be a slave to two different Icons at the same
time as this would represent a conflict of control. To automatically create a bidirectional
link, check the ‘Create a Bidirectional Link’ checkbox in the properties dialog.

By right-clicking on the link, the Link Properties tab will be shown. The user can select
the linking rules in effect for this link.
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Link types are:

Group Level
(Inverse Proportional Radius)

This is essentially the ‘Master Fader’ link
type. As the link Master Mix Icon is
adjusted from maximum (inner radius) to
minimum (outer radius), the Slave Mix
Icon is adjusted from (where it was when
the link was created) to the minimum
(outer radius). This is most useful as a
single direction link.
Multiple Slave Mix Icons, with settings at
different levels, could all be faded out to
the minimum settings, by adjusting the
single Master Mix Icon.

Group Pan
(Pan Offset)

This link type maintains a constant ‘Pan
Angle’ offset between the Master Icon and
the Slave Icon(s).

Same Level
(Same Radius)

This link type sets the Slave icon to the
same radius (with respect to Max and Min)
as the Master icon. This is equivalent to
‘grouping faders’ on a conventional mix
console. The slave pan angle is not
changed.
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Same Pan
(Same Angle)

This link type sets the Slave icon to the
same pan angle as the Master icon. This is
equivalent to ‘grouping panpots’ on a
conventional mix console. The slave radius
(volume level) is not changed.

Cross Fade This link type sets the Slave icon to the
inverse radius (with respect to Max and
Min) as the Master icon. This is useful to
‘cross-fade’ level controls.

Cross Pan This link type sets the Slave icon to the
opposite pan angle as the Master icon. This
is useful for ‘cross-pan’ arrangements.

Same Level and Pan This link type sets the Slave icon to the
same radius and pan angle as the Master
icon. This is equivalent to ‘grouping faders
and panners’ on a conventional mix
console.

Same Level, Mirror Pan
(Horizontal Mirror)

This link type sets the Slave icon to the
same radius but (front-to-back) opposite
pan angle as the Master icon. The Slave
icon pan angle behaves as if it were
reflected in a ‘horizontal mirror’. This is
most useful on Surround Mix Form types.

Same Level, Mirror Pan
(Vertical Mirror)

This link type sets the Slave icon to the
same radius but (left-to-right) opposite pan
angle as the Master icon. The Slave icon
pan angle behaves as if it were reflected in
a ‘vertical mirror’.

Same Level, Opposite Pan
(Spherical Mirror)

This link type sets the Slave icon to the
same radius but (left-to-right and front-to-
back) opposite pan angle as the Master
icon. The Slave icon pan angle behaves as
if it were reflected in a ‘spherical mirror’.
For example, if the Master icon is placed to
the front and right, the Slave icon will be
positioned to the rear and left.
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Same X The Slave Icon has the same X coordinate
as the Master Icon, its Y coordinate is
preserved.

Same Y The Slave Icon has the same Y coordinate
as the Master Icon, its X coordinate is
preserved.

Offset Label
(Constant X/Y Offset)

The Slave Icon maintains a constant X and
Y offset relative to the Master Icon. This is
primarily useful if the user wants to ‘label’
a mix icon (for example, label a knob with
a ‘picture’ of the content on that channel).
This way the picture will track the position
of the link Master icon.

Inverse Group Level
(Proportional Radius)

This is essentially the ‘Inverse Master
Fader’ link type. As the link Master Mix
Icon is adjusted from maximum (inner
radius) to minimum (outer radius), the
Slave Mix Icon is adjusted from the
maximum (inner radius) to (where it was
when the link was created. This is most
useful as a single direction link in a Master
Fader configuration where the user has set
the outer radius as the maximum volume or
signal level.

Group Switch This link type allows switches to be ganged
together. The Master icon switch setting
controls the switch settings of the linked
Slave icons. The positions of the icons on
the mix form are not changed.

Group Switch and Position This link type allows switches to be ganged
together. The Master icon switch setting
controls the switch settings of the linked
Slave icons. The positions of the icons are
also linked for both Pan and Fade (angle
and radius).
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Group Mute This link type allows the Mute state of Mix
Icons to be ganged together. The Master
icon mute setting controls the mute settings
of the linked Slave icons. The positions of
the icons on the mix form are not changed.

Group Mute and Position This link type allows the Mute state of Mix
Icons to be ganged together. The Master
icon mute setting controls the mute settings
of the linked Slave icons. The positions of
the icons are also linked for both Pan and
Fade (angle and radius).

Group Solo This link type allows the Solo state of Mix
Icons to be ganged together. The Master
icon solo setting controls the solo settings
of the linked Slave icons. The positions of
the icons on the mix form are not changed.

Group Solo and Position This link type allows the Solo state of Mix
Icons to be ganged together. The Master
icon solo setting controls the solo settings
of the linked Slave icons. The positions of
the icons are also linked for both Pan and
Fade (angle and radius).

Group Mute, Solo, and Position This link type allows the Solo and the Mute
state of Mix Icons to be ganged together.
The Master icon solo and mute settings
controls the solo and mute settings of the
linked Slave icons. The positions of the
icons are also linked for both Pan and Fade
(angle and radius).

Group Fader This link type allows the Fader (or knob)
position of Mix Icons to be ganged
together. The Master icon fader settings
controls the fader settings of the linked
Slave icons. The positions of the icons on
the mix form are not changed.
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Group Fader and Position This link type allows the Fader (or knob)
position of Mix Icons to be ganged
together. The Master icon fader settings
controls the fader settings of the linked
Slave icons. The positions of the icons are
also linked for both Pan and Fade (angle
and radius).

Invert Switch This link type allows switches to be ganged
together inversely. The Master icon switch
setting sets the switch settings of the linked
Slave icons to the opposite state. The
positions of the icons on the mix form are
not changed.

Group All States This link type allows the Fader (or knob)
position, and the Mute, Solo, and Switch
states of Mix Icons to be ganged together.
The Master icon settings controls the
settings of the linked Slave icons. The
positions of the icons on the mix form are
not changed.

Group All States and Position This link type allows the Fader (or knob)
position, and the Mute, Solo, and Switch
states of Mix Icons to be ganged together.
The Master icon settings controls the
settings of the linked Slave icons. The
positions of the icons are also linked for
both Pan and Fade (angle and radius).

If the slave Mix Icon has movement constraints selected then they will ‘overrule’ the
linking rules unless the ‘Apply linked icon’s constraints during drag operations’ box is
un-checked.

Links may be shown or hidden by using the ‘Link Options…’ dialog box under the
Options menu. (See Link Options below.) The combo box on the link properties dialog
box allows the user to specify one of the following options:

Show Normal Default. Show only links or selected mix
icon or show all links depending on link
options setting.

Show Even If Disabled Show this particular link even if it would
not normally be shown.
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Hide Even If Display Is Enabled Hide this particular link even if it would
normally be shown.

To remove a link, select it with a left-click, and then type the <DEL> key.

Note that a ‘Bidirectional link’ is really two independent, cross-pointing unidirectional
links. It is possible to delete one link of the two (using the Mix Icon Properties dialog),
even if the “Create a Bidirectional Link’ checkbox is set. If you have difficulty with this,
simply delete both links and create them anew.

Mix Icon Linked Mix Forms
In GraphiMix, a <right-click> on an Icon brings up a context menu. One of the selections
(in Build Mode) is “Assign Linked Form”. An Icon can be linked to one or more Mix
Forms, which are referred to as ‘Linked’ Mix forms. These are commonly used to hold
equalization or effects controls for a particular channel which is represented as a Mix
Icon.

All Linked Mix Forms that are linked to a particular icon will show up as entries on that
Mix Icon’s context menu for easy selection. Note that any type of control can be placed
and used on a Linked Mix Form. Multiple Mix Forms can be linked to a single Icon.
Once assigned, linked Mix Forms can be deassigned, hidden, or shown. Note that the
‘Linked’ form actions (Hide, Show, Assign, Deassign) and the Find and Replace entry
are only shown on this context menu when GraphiMix is in ‘Build’ mode.
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Normal Mix Icons
A Normal Mix Icon is a Mix Icon with four internal states ( Solo On and Off, Mute On
and Off). It is represented by an image that may be made from text with selectable
background and foreground colors and fonts, or graphics imported from a windows
bitmap file (BMP). Compressed bitmaps are not currently supported. Each Mix Icon has
3 types of images associated with it, the Normal image, the Bright image, and the Dim
image. The Normal image is the image displayed when the Icon is in active use. The Dim
image is displayed when the Mix Icon is in the ‘Mute’state, or when the Icon is disabled.
The Bright image is displayed when the Mix Icon is put into the ‘Solo’ state.  Each
normal Mix Icon image type has 3 sizes that it can switch to depending on the size of the
Mix Form that it is placed on and the setting in the Options Menu->Icon Size Options
dialog. Therefore each Normal Mix Icon has 9 images associated with it.

A Normal Mix Icon, when placed on a Mix Form, has 14 sets of coordinates defined.
These are: Radius, Theta, X, Y, and Inverse version of these, for a total of 8, and
MuteOn, MuteOff,  SoloOn, and SoloOff. There are also two ‘special’ coordinates,
ThetaRadius, and XY, that are used for the ‘Surround’ data types.

Complex Mix Icons
A Complex Mix Icon is a Mix Icon with additional coordinates and more internal states.
There are 4 Complex Mix Icon types, Switches, Knobs, Faders, and List icons.

Switches
A Switch Mix Icon type has 2 additional internal states, On and Off. Each State can be
represented by any kind of Normal Mix Icon type, for example text or a windows bitmap.
A switch Mix Icon therefore has 18 associated images, 9 for each state.

There are two different types of switch Icons, a Toggle switch and a Momentary switch.

A switch Icon adds two additional coordinates to the Mix Icon Coordinate selection,
‘SwitchToOn’ and ‘SwitchToOff’. Any controls ‘attached’ to these coordinates send
messages only on these events.

Knobs and Faders
Knob and Fader Mix Icon Controls are a special type of Complex Mix Icon. The user can
customize the look of Knobs and Faders by using the Edit/Create Icon Tool available on
the Tools menu.  These types can be different sizes, have different foreground and
background colors and have labeled ‘tick marks’ (knob only). The Knobs and Fader types
can be set, at run time, to 100 different positions, by holding down the <control> key and
dragging the knob with the mouse to the desired setting. There are two separate Fader
Mix Icon types, Vertical and Horizontal.
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Knobs and Fader Mix Icons add two additional coordinates to the Mix Icon Coordinate
selection drop-down list, Fader and Inverse Fader. Any controls ‘attached’ to these
coordinates are affected only by the setting of the knob (or slider).

Fader Mix Icons can be set to ‘scale’ their size to a fraction of the Mix Form size. If this
option is selected, the Fader Mix Icons will change their size as the Mix Form size is
adjusted to be a constant, selectable fraction of the Mix Form size. This is set in the Mix
Icon Properties dialog for the Fader Mix Icon. The value to set is in ‘percent of total Mix
Form size’.

Indexed List Icons
The Indexed List Icon is a special type of Complex Mix Icon. It is essentially a multiple-
selection switch with a text string for each entry. The entries are contained in a text file of
text strings (one per line) with the file extension ‘VTL’. Each value of the control
between Min and Max indexes to the corresponding text entry in this file.

This control is especially useful for routers or multi-function switches.
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The user can create a List icon by using the Edit/Create Icon Tool available on the Tools
menu and selecting ‘Indexed List’ as the icon type.

The List icon adds an additional coordinate, ‘ListIndex’, to the Mix Icon Coordinate
selection drop-down list. Any controls ‘attached’ to this coordinate are affected by the
setting of the list icon.
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Mix Icon Properties
The Mix Icon Properties tabbed dialog box appears when the user right-clicks on any Mix
Icon and selects the ‘Properties’ entry. Tabs along the top of the dialog box select sub-
pages of dialogs on specific topics.

Properties
This tab contains a Name field to name the Mix Icon. The name of the mix icon will
show up as a tool tip when the cursor rests over a mix icon.

This tab contains a Constraints select box to select the Mix Icon Constraints.

The movement of the Mix Icon on its Mix Form can be constrained in several ways.

These movement constraints are:

Unconstrained Free movement, limited only to the Mix
Form.

Constant Radius The Mix Icon movement is limited to
maintaining a constant radius around the
Mix Form Origin.
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Constant Angle. The Mix Icon movement is limited to
maintaining a constant angle relative to the
Mix Form Origin

Constant X The Mix Icon movement is limited to
maintaining a constant X coordinate
relative to the Mix Form Origin.

Constant Y The Mix Icon movement is limited to
maintaining a constant Y coordinate
relative to the Mix Form Origin.

Fixed Position The Mix Icon movement is limited to
maintaining a fixed position relative to the
Mix Form Origin.

This tab contains a slider bar for ‘Mouse Smoothing During Drag Operations’.  This
allows the Mix Icon movement range from 'quick and responsive' (No smoothing) to
'slow and smooth' (Maximum smoothing).

The check box called ‘Allow Left Click’ determines whether or not the mix icon will
respond to a left click.  Disabling the response to a left click can be used to create a mix
icon that will remain in place during normal usage. Such an icon may be used as a label
or a visual calibration mark.

The ‘Click on Transparent Pixel’ determines whether or not a left click on a mix icon will
take place when the click happens to be on a transparent pixel.  Normally a click on a
transparent pixel is ignored. However in some cases, such as with text-based icons, the
user may want to make it easier to click on an icon.

The ‘Send Midi on Mix Form Left Click’ check box determines whether or not this mix
icon sends its MIDI data when the user left clicks on the mix form. Normally, MIDI data
is sent only when the icon is moved, or its state changed, or when the Mix State is loaded
or changed.
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The three checkboxes to the left in this tab indicate the Enabled, Soloed, or Muted state
of the Mix Icon. A Mix Icon will show as ‘dim’ if the Mix Icon is disabled, or if it is in
the Mute state. A text box will show in this tab if the icon is in the ‘dim’ state to explain
the reason for being dim.

Master Links
This tab contains information about any Mix Icon Links to this Icon from a master icon.
A link to this Icon would indicate that the position of the Mix Icon is controlled by the
position of another Mix Icon.
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Slave Links
This tab contains information about any Slave Mix Icons linked to this Icon. A slave link
from this Icon would indicate that the position of this Mix Icon controls the position of
another Mix Icon. For more information about linking Mix Icons, see Mix Icon Linking,
page 43.
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Controls
This tab allows the user to configure the controls that are attached to this Mix Icon.

Mix Icons control sound by sending commands to audio controls. Each Mix Icon can
control an arbitrary number of audio controls or effects parameters allowing very
powerful control of audio with simple movements of Mix Icons.

GraphiMix incorporates an extremely flexible and extensible scheme for selecting and
controlling individual and arbitrary parameters by setting the position of a Mix Icon on a
Mix Form. Each placement of the Mix Icon establishes its position in the Mix Form
Coordinate system. These coordinates are translated into messages that are sent to the
controls individually.

Currently only MIDI and INTERNAL message protocols are supported. This will
eventually be extended to other protocols such as TCP/IP and RS422.

Two buttons at the top allow the user to insert a new control (Insert CTRL) or delete one
(Delete CTRL). Controls are selected by clicking on the tabs at the bottom of the page.
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The controls can be named by typing a name like 'Fader12' or 'PanPot' into the 'Name'
text box. The control will have a default name, 'ctrl<sequence number>', if no name text
is entered.
Each control can be individually disabled by un-checking the Enable check box.

The VSL File field contains a list of VSL files. VSL files contain the message protocol
information for each supported audio control. These controls in any particular file are
typically all of the controls for a particular piece of audio hardware such as a PC sound
card or a Yamaha ProMix01™ or any piece of equipment that can be controlled by a
message. This field will list all available VSL files in the GraphiMix directory. The user
needs to select one of the available files.

The Component field lists all of the available components in the selected VSL file. The
user needs to select one of the available components. If there is no component specified
in the VSL file, the string ‘<default>’ will appear in the Component field.

The Control field lists all of the available controls in the selected Component for the
selected VSL file. The user needs to select one from the list of available Controls.

The Data Type field lists all the available methods for converting a Mix Icon coordinate
to the appropriate parameter in the audio hardware being controlled.

Currently available Data Type methods are:

Single Channel Methods

Fader Single channel fader (usually) assigned to
the Radius Coordinate

PanPot Single PanPot control (usually) assigned to
the Theta Coordinate

SurroundPanPot Single 360 degree PanPot control (usually)
assigned to the Theta coordinate

Multichannel Methods

PanFaderLeft Simulate a panpot/fader combo with 2
single channel faders.
Usually assigned to the ThetaRadius
Coordinate.
Index selects variable bank.
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PanFaderRight Usually assigned to the ThetaRadius
Coordinate.
Index selects variable bank.

QuadFaderLeftFront Simulate a discrete 4 channel surround mix
with 4 single channel faders usually
assigned to the ThetaRadius Coordinate.
Index selects variable bank.

QuadFaderRightFront “”
QuadFaderLeftRear “”
QuadFaderRightRear “”
QuadFaderCenter Front-center method

Custom Methods

Custom Custom methods (none currently)

The PanFader and QuadFader Data Types use the Mix Icon Control Index field <0-9> to
select which variable bank is being used for this control. For more information, see the
Appendix, GraphiMix Internal Variables and Commands, page 159.

The Coordinate field lists all available Mix Icon Coordinates to be used in converting the
Mix Icon position to a parameter message sent to a control. Currently available
coordinates are:

Radius Use Mix Icon Radius coordinate as input to
Data Type method.

Theta Use Mix Icon Theta coordinate as input to
Data Type method

ThetaRadius Use Mix Icon Theta and Radius
coordinates as input to (MultiChannel)
Data Type methods

X Use Mix Icon X coordinate as input to Data
Type method.

Y Use Mix Icon Y coordinate as input to Data
Type method.

XY Use Mix Icon X and Y coordinates as input
to (MultiChannel) Data Type methods.

InverseRadius Use Mix Icon Inverse Radius coordinate as
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input to Data Type method.

InverseTheta Use Mix Icon Inverse Theta coordinate as
input to Data Type method.

InverseX Use Mix Icon Inverse X coordinate as input
to Data Type method.

InverseY Use Mix Icon Inverse Y coordinate as input
to Data Type method.

Fader Optional Coordinates available on Knob,
Vertical, and Horizontal Fader Mix Icon
types.

Inverse Fader Optional Coordinates available on Knob,
Vertical, and Horizontal Fader Mix Icon
types.

SwitchToOn Optional Coordinates available on Switch
Mix Icon types.

SwitchToOff Optional Coordinates available on Switch
Mix Icon types.

SoloOn Coordinate activates when Mix Icon is put
in solo mode.

SoloOff Coordinate activates when Mix Icon is
switched from solo mode.

MuteOn Coordinate activates when Mix Icon is put
in Mute mode.

MuteOff Coordinate activates when Mix Icon is
switched from Mute mode.

ListIndex Coordinate available on List Mix Icon
types.

The Description field holds information for the user identifying the control and other
pertinent information so the user can correctly program this control. For instance, any use
of the Index, Parameter, or Program fields should be shown here.
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The Protocol field selects either MIDI, or INTERNAL.  The INTERNAL Protocols are
described in Voyager Internal Variables and Commands in the appendix and in the
VygrInternal.VSL file.

If the MIDI Protocol is selected then the MIDI parameter fields will be used.
The first MIDI parameter field is the MIDI Channel. This selects the MIDI Channel
number used in the MIDI message sent to the audio control.

The Parameter field, the Index field, and the Program fields are optionally used to set
parameters in the MIDI message dependent on the particular control and how it is written
in the VSL file. For more information, see the Appendix, Voyager System Language
(VSL) Description, page 142.

Radius Mapping
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Radius Mapping is a mapping from the physical radius of a mix icon to the value that is
converted into MIDI.  The mapping may be linear or non-linear.  Radius mapping allows
the user to make better use of the available space on a mix form and to match the
characteristics of hardware devices.  For example, there may not be enough room near the
center of the mix form to conveniently place all of the mix icons that need to be near the
center.  In this case, the radius mapping mechanism can allow the user to effectively
expand the center region to make more room.

The horizontal axis in this graph shows the Mix Icon radius as shown on the Mix Form.
The vertical axis represents the output value sent to the control. Note that at the left side
of the graph, there is a ‘flat’ area where the output value is zero, yet the icon has a small
radius. If ‘inverse radius’ is used as the control coordinate this icon radius would
represent a control maximum value.

There are two parts to the radius mapping. The first part is the ‘flat radius’ value.  The
flat radius value allows the user to specify a radius, in percent, over which the
corresponding midi output will be constant.  All radii with a value less than or equal to
the flat radius will use a mapped radius of 0 when computing MIDI input or output. Each
mix form has a single value of the flat radius value.  All mix icons on the same mix form
share the same flat radius value.  When the flat radius is changed for one mix icon, it
changes automatically for all mix icons on the same mix form.

The second part of the radius mapping is the ‘radius mapping value’.  The radius
mapping value changes the shape of the mapping curve.  When the radius mapping value
is small, then the slope of the mapping curve will be small at small radii and large at large
radii.  When the radius mapping value is large, then the slope of the mapping curve will
be large at small radii and small at large radii. When the radius mapping value is set to 50
percent, the mapping is linear, i.e. has a constant slope throughout.

The radius mapping value may also be changed by using a control-mouse wheel action.
This results in a small image of the mapping being shown at the cursor position. In this
case the flat radius value is not changed.

The radius mapping attributes may be modified in a total of four different ways:

Action Flat Radius Value Radius Mapping Value
Right Click On Mix Icon,
select Properties, then select
Radius Mapping Tab

Changes flat radius for all
mix icons on the mix form.

Changes radius mapping for
this mix icon only
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Right Click On Mix Form,
select Properties, then select
Radius Mapping Tab

Changes flat radius for all
mix icons on the mix form

Changes the default radius
mapping used by new mix
icons

The Edit Preferences Menu
(Select Radius Mapping
Tab)

Changes the default flat
radius used by new mix
forms

Changes the default radius
mapping used by new mix
forms.

Control-Mouse wheel No Change Changes radius mapping for
selected mix icon only

Weecons

Weecons are tiny (‘wee’) icons that are optionally added to the lower left corner of a Mix
Icon to further identify it.

Weecons for an individual Mix Icon are selected right-clicking on a selected Mix Icon to
bring up the Mix Icon Properties->Weecons tab.
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It may be necessary to use the same image to represent multiple Mix Icons on a single
Mix Form. An example would be 5 microphone icons in a live venue. Small identifying
tags can be added to the displayed Mix Icon to distinguish otherwise identical icon
images. For example, 5 microphone icons could be used, each with tags attached with
unique numbers 1 through 5 corresponding to channels 1 through 5.

This tab includes a library of Mix Icon Weecon images. The images can be displayed
double size as a check box option. The weecons can be separately enabled or disabled
and can be de-assigned once assigned.

Image
This tab features a menu of available Mix Icon Images in all VLB windows. The selected
Image will represent the position of the Mix Icon on the Mix Form.
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The Images tab can also be accessed from a Mix Icon’s context menu  by clicking on
‘Select Image…’ .
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Dynamic Status
The Dynamic Status display feature provides a calibrated readout of the target mix
hardware settings as the Mix Icon is moved on the Mix Form. Up to two displays per icon
can be shown, and they can be displayed in any one of three positions relative to the
placement of the Mix Icon.

The Dynamic Status value displayed is a linear interpolation between the two nearest
Tick marks, taking into account any Radius Mapping settings. For more accuracy, more
Tick marks can be generated.
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There are three steps that the user must complete before Dynamic Status Displays can be
used.

The first step is to create a Mix Form Axis by selecting the Mix Form and selecting the
Backgrounds tab. To do this, <right-click> on the Mix Form background and select
‘Properties’(with GraphiMix in ‘Build’ mode). Then click on the ‘Backgrounds’ tab at
the top of the properties dialog.
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Add an Axis and give it a name. This name will be referred to when setting up the rest of
the Dynamic Display. Axes can be customized to almost any degree. However, this
flexibility brings complexity. Iterate until the Axis calibration looks correct (it can be
fine-tuned later). Note that the Axis itself can be hidden so that only the Dynamic Status
displays indicate the settings and so the Mix Form is less cluttered. Hide it when done.
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After defining a Mix Form Axis, the next step involves associating a particular control on
a Mix Icon with this Axis.

Do this by bringing up the Mix Icon Properties page (<right-click, select ‘Properties’) and
selecting the Controls tab. Select the appropriate control by clicking on the appropriate
tab at the bottom of this dialog. Now select the Calibration Axis from the drop-down list
of available Mix Form Axes.
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Finally, select the Dynamic Status tab of the Mix Icon Properties dialog and set either the
Primary Status Display (top or left) or the Secondary Status Display (bottom or right) and
select the Midi Control Name of the Mix Icon Control to be displayed. The Display Style
drop-down list selects where the Dynamic Display is placed. The user can also select
when and how the Display is printed and the Text Color.
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Here is the result with the Mix Form Axis hidden.

Scenes and States
The entire GraphiMix mix surface including all of the Mix Form and Mix Icon positions
and configurations may be saved as a ‘state’. This state can also be recalled, allowing for
the implementation of presets for specific Mix settings. These presets are stored as Mix
States. One or more Mix States may be grouped together in a Scene, and there may be
one or more Scenes in a specific GraphiMix session. This allows for incredible
flexibility, allowing the user to entirely reconfigure his mix hardware and how he
perceives and uses it individually for each scene or state with the touch of a mouse or
keyboard button.

Scenes and states can also be ‘Attached to’ MIDI messages. Changing the state can cause
a MIDI message to be sent to some target hardware or application. Similarly, GraphiMix
can respond to an incoming MIDI message and change the state accordingly. For more
information, see Options Menu, Attach States To Midi Option, page 104.

To make it convenient to access Scenes and States there are several on-screen tools
available. These are on the Mix Form Tool Bar, the Scene and State Tool Bar, the Scene
and States view window, and the Scene and State Tab bar. These can be accessed via the
View Menu.  See View Menu on page 87 for more details.
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An example of a session with several Scenes and States is shown above. In Scene1:State1
there are two Mix Forms shown, “Jazz Ensemble” and “Drum Sub”.
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In State2, there are 3 Mix Forms shown, “Quartet Main”, “Surround 1”, and “Bass
Graphic”.

Here is the Scenes and States View Window for the above example. Both Scene1 and
Scene2 have 3 states each. The names for particular scenes and states can be changed in
this window by “editing in place” or by right-clicking on the appropriate scene or state
and filling in the Name dialog box.
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There is a Graphic Preview Mode for the ‘next’ state feature available. This mode is
available on the Scenes and States Tool Bar as the ‘Pr’ button.  If this button is clicked,
the next state appears, but no control messages are sent. A timer will appear and start
‘ticking down’. While the timer bar is ‘ticking down’ the user has the option of ‘keeping’
the displayed state by clicking the ‘Keep’ button. If the user doesn’t click the ‘Keep’
button, the display reverts to the previous state. If the user does click the ‘Keep’ button,
the new state is applied and the appropriate control messages are sent.

The Graphic Preview Timeout time is set in the Edit->Preferences menu. See Edit Menu,
Preferences, page 87.

Tool Bars, Tab Bars, and Icon Bars
Most Tool bars and Tab Bars can be attached to any side of the Mix Frame or can be
‘floated free’ to become their own independent window. One exception to this is the
Scene and State Tab Bar which remains fixed to the bottom of the Mix Frame.

Standard Tool Bar
The Standard Tool Bar contains buttons that Save the session, Cut the selected Mix Icon
(or Mix Form) to the windows clipboard, Copy the selected Mix Icon (or Mix Form) to
the clipboard, Insert the Mix Icon (or Mix Form) from the clipboard, select About
Voyager (for version number info), bring covered Mix Forms to the Front, select between
Run Mode and Builder Mode, and to select Mix Form Group Mode on and off.

Save session

Cut selected Mix Icon or Mix Form

Copy selected Mix Icon or Mix Form

Paste selected object from Windows Clipboard

Bring up ‘About’ dialog for GraphiMix version information

Bring to Front Button.

Run Mode   (button out)

Build Mode (button in)

Mix Form Group Mode off (button out)

Mix Form Group Mode on (button in)
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When GraphiMix is in Run mode, certain entries on Mix Icon and Mix Form context
menus are removed. This simplifies the menus by removing items that only pertain to
designing and building a GraphiMix mix surface. Only entries that the engineer needs to
use during the session are shown.

Context
Menu in Run
Mode

Context
Menu in
Build Mode

To print a Mix Form, select the Mix Form to be printed and then use the <Alt-
PrintScreen> keys on the keyboard. This copies the image to the Windows clipboard.
Then start a ‘paint’ application such as ‘MS Paint’ and paste in the image from the
clipboard. This image can then be printed.

Mix Form Tool Bar
The Mix Form Tool Bar contains five tools that help in the creation of a Mix session.
These tools are from left to right (or top to bottom), the New Scene tool, the New State
tool, the New Mix Form tool, the New Mix Icon tool and the Mix Icon Link tool.
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This tool bar can be dragged from the Mix Frame and placed freely anywhere on the
user’s desktop or attached to the Mix Frame edges.

For more information please see:
Mix Forms and Mix Form Coordinates, page 13,
Mix Icons and Controls, page 40.

Scenes and States Tool Bar
The Scenes and States Tool Bar has a series of arrow tool buttons that allow the user to
move forward and backward by Scene (the outer arrows) or State (the inner arrows). The
‘Pr’ button selects a graphic preview mode for the next state.

If the Graphic Preview Mode button is clicked, the next state appears, but no control
messages are sent. While the timer bar is ‘ticking down’ the user has the option of
‘keeping’ the displayed state by clicking the ‘Keep’ button. If the user doesn’t click the
‘Keep’ button, the display reverts to the previous state. If the user does click the ‘Keep’
button, the new state is applied and the new control messages are sent.
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Scenes and States Tab Bar
The Scene and State Tab bar shows the current Scene and State for the mix as well as all
Mix Forms in the current state. The user can directly click on a Mix Form, a Scene tab or
a State tab and switch directly to the selected scene and state and bringing the selected
Mix Form to the front.

You may edit the name of any item in the Scene and State Tab bar by double clicking on
the item. You may also re-order the items by dragging them.

Icon Bars

Icon bars are user definable tool bars that can contain Mix Icons. To create an Icon Bar
see Insert Menu, New Icon Bar, page 100. Icon bars can be ‘hidden’ and displayed
horizontally or vertically.

This is an example of an Icon Bar that is ‘floating free’.

This is an example of the
same toolbar docked on
the top of the GraphiMix
mainframe.
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If the user <right-clicks> on any icon on the Icon bar, the Icon Bar context menu will
appear. This allows the user to Mute and Solo the Mix Icon, Delete the Mix Icon, Hide or
Delete the Icon Bar, switch between Vertical and Horizontal orientation, display of small,
medium or large Mix Icons, and to select Mix Icon and Icon Bar Properties.

Shown below is the Icon Bar Properties dialog. This allows the user to set the Icon Bar
Size, and its orientation, and to provide a name for the Icon Bar.
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Shown below is the Mix Icon Properties dialog accessed from the Icon Bar context menu.
This is similar to the Mix Icon Properties available on a <right-click> on a Mix Icon
placed on a Mix Form, but with fewer options. For more information on Mix Icon
Properties, see Mix Icon Properties, page 54.
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Menus
At the top of the Mix Frame window are arrayed all of the GraphiMix menus. These
menus provide access to all the GraphiMix application functions.

Also shown is the Standard Tool Bar.

File Menu
This menu can also be selected by typing <Alt> then ‘F’.

New Starts a new Voyager project.

Open Opens a Voyager project.

Close Closes and saves the project.

Save Saves the current project.
Disabled in the Demo version.

Save-As Saves the project with the option for
another filename.
Disabled in the Demo version.

Export Environment Saves all files needed for a particular
GraphiMix session except the VOY
(session file) so that a GraphiMix session
can be easily moved to another PC or
installation.

Import Environment Restores all files needed for a particular
GraphiMix session except the VOY
(session file) so that a GraphiMix session
can be easily moved to another PC or
installation.

Most Recent Session List … The most recent 10 session files opened or
saved in GraphiMix.
Selecting one of these files automatically
opens that session.
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Exit EXIT the program.

Export Environment…
The session environment is all of the associated files that are used and referred to in a
particular GraphiMix session. This includes the files that hold the hardware protocols, the
VSLs, and the files that store the Mix Icon data structures and images, the VLBs. Note,
that the session itself is separate from the environment, and is stored as a named file with
the extension “.voy”.

These files have to be in particular directories or subdirectories in order to be useable by
GraphiMix.

The Export Environment… selection brings up a series of dialogs that result in saving the
GraphiMix environment, in all or part, to a named file with the extension “.vxp”.

The first dialog prompts the user to select whether he wants to export just the VLBs and
VSLs that are required by the current GraphiMix session, or all files.

The next dialog prompts for its name and where to save it.
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Finally, a status dialog appears with Export Environment statistics.

Import Environment…

The Import Environment… selection brings up a series of dialogs that result in loading
files into the GraphiMix environment from a named file with the extension “.vxp”.

Note that although the files may be transferred, the current GraphiMix variant must be
sufficiently licensed to enable their use.

The first dialog prompts for the environment export file folder and name.

The next dialog shows the Import Environment statistics. Older files will not overwrite
newer files.
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Edit Menu
This menu can also be selected by typing <Alt> then ‘E’.

Preferences … Sets Options that affect the run-time
performance of the GraphiMix system

Find and Replace …. Brings up the Find and Replace dialog to
enable automatic search and replacement of
Mix Icon parameters.

Cut Mix Icon If a Mix Icon is selected (Red box around
icon image) then this menu item appears.
Cut Mix Icon to windows clipboard.

Copy Mix Icon If a Mix Icon is selected (Red box around
icon image) then this menu item appears.
Copy Mix Icon to windows clipboard.

Paste Mix Icon If a Mix Icon is on the windows clipboard
from a previous Cut or Copy operation,
then this menu item appears.
Copy Mix Icon from windows clipboard to
currently selected Mix Form.

Delete Mix Icon If a Mix Icon is selected (Red box around
icon image) then this menu item appears.
Delete Mix Icon.

Cut Mix Form If a Mix Form is selected ( title bar
highlighted in blue ) then this menu item
appears.
Cut Mix Form to windows clipboard.

Copy Mix Form If a Mix Form is selected ( title bar
highlighted in blue ) then this menu item
appears.
Copy Mix Form to windows clipboard.
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Paste Mix Form If a Mix Form is on the windows clipboard
from a previous Cut or Copy operation,
then this menu item appears.
Copy Mix Form from windows clipboard.

Delete Mix Form If a Mix Form is selected ( title bar
highlighted in blue ) then this menu item
appears.
Delete selected Mix Form.

Cut State Cut current State (with all of its Mix
Forms, Icons, and attached controls) to
windows clipboard.

Copy State Copy current State (with all of its Mix
Forms, Icons, and attached controls) to
windows clipboard.

Paste State If a State is on the windows clipboard from
a previous Cut or Copy operation, then this
menu item appears.
Copy State from windows clipboard.

Delete State If there are two or more States in the
session, then this menu item appears.

Cut Scene Cut current Scene (with all of its States,
Mix Forms, Icons, and attached controls) to
windows clipboard.

Copy Scene Copy current Scene (with all of its States,
Mix Forms, Icons, and attached controls) to
windows clipboard.

Paste Scene If a Scene is on the windows clipboard
from a previous Cut or Copy operation,
then this menu item appears.
Copy Scene from windows clipboard.

Delete Scene If there are two or more Scenes in the
session, then this menu item appears.
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Paste Axis If an Axis is on the windows clipboard
from a previous Cut or Copy operation,
then this menu item appears. To Cut or
Copy an Axis, see Mix Form Properties,
Backgrounds, page 22.
Copy Axis from windows clipboard to
currently selected Mix Form.

Preferences
This tabbed dialog allows the user to read and modify global and default settings for
various GraphiMix operational parameters.

Timing

This dialog sets various parameters related to timing within GraphiMix.

The Graphic Preview Time Out slider sets the time that the Graphic Preview timer bar
takes to ‘tick down’. For more information see Scenes and States Tool Bar, page 78.
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The Responsiveness number entry box sets a relative level of CPU loading as GraphiMix
executes. For hardware console applications, this should normally be left at 100.  If
GraphiMix is being used on the same CPU with other time-critical applications, for
example a Digital Audio Workstation application, the user may want to set this to 89 or
below. Graphic redraws of Icon positions can be CPU intensive. As this number is set
lower, GraphiMix redraws happen at lower priorities and with more ‘forced context
switches’ to allow other tasks to use more of the CPU. Although graphic drawing may lag
behind the actual icon moves, all MIDI input and output based on icon positions happen
at normal priority.

The Default CCSST timer setting number entry box sets the standoff timer value for
change of control of a particular Mix Icon between MIDI input (external control) or User
mouse and keyboard input (internal control). This time needs to be set long enough to
transfer all controls’ MIDI messages to the target hardware on a scene or state change,
otherwise echoed messages may ‘push back’ on the icon movements. The more controls
that are in a particular state, the larger this number has to be. This number also has to be
set larger if external MIDI is used rather then GraphiPorts because of the slower data rate.
Setting this to a large timeout is only a problem if the user is using both the external
hardware/application and GraphiMix to set the same control; the user then must wait this
amount of time before switching which surface he is using.

The MIDI Delay Timer number entry box sets a delay after each MIDI message is sent to
avoid problems with slower MIDI devices and causing MIDI overrun errors.

Misc.
The Miscellaneous tab holds settings that don’t belong on any other tab.
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The ‘Set Default Background Color’ button allows the user to select the background
color that will be used for new mix forms. This also changes the current background
color displayed in the VLB windows.

The ’Issue Warning on Icon Delete’ checkbox sets whether the user is alerted when he
attempts to delete a Mix Icon.
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Radius Mapping
The radius mapping tab of the preferences dialog box allows the user to specify the
default radius mapping that will be used for new mix forms. Radius mapping is described
in the Radius Mapping section, page 34.
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Snap To Grid

The ‘Snap To Grid’ feature allows mix icons to be aligned relative to a grid.  The X and
Y grid spacing are specified in percent. When this feature is enabled, any mix icon which
is manually dragged by using the mouse, will slide to the nearest grid point when the drag
operation is completed.
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When ‘snap to grid’ is enabled, the mix form background will show a red dot for each
grid point. This feature is useful when setting up Mix Forms with arrays of controls that
will be fixed in place. After the Mix Icons have been placed and their position fixed, this
feature can be disabled.
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Global Preferences

The Global Preferences tab allows the user to determine whether GraphiMix will
automatically open the last session file in use when it starts up.

The user can also set whether to display all VLB windows when the View Menu->View
Icon Windows is selected by checking the ‘Show all the VLB windows by default’
checkbox. The default behavior is to display the Primary VLB window only.
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Find And Replace

The Find and Replace facility, accessed in the Edit menu and in the Mix Form and Mix
Icon context menus (in Build Mode), allows the user to quickly change the attributes of
many mix icon controls. This is useful, for example, to change all (or a subset) of the
controls from one midi channel assignment to another.

The search criteria are specified using the data on the left half of the dialog box. To
include a field as a part of the search criteria, check the appropriate box and enter the
value which will be searched for.  Be sure to select the appropriate VSL file first since the
displayed fields are dependant on this choice. Then you must select the appropriate
Component since the controls depend on the selected component.

All checked search criteria must be met simultaneously in order for a particular control to
pass the search condition.  In some circumstances the user may want to leave all the
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search criteria unchecked in order to apply the change to all mix icon controls. All of the
unchecked fields are ‘wildcarded’.

The ‘Change to’ fields on the right hand side of the dialog box specify what to change the
field to.  When the all search criteria are satisfied, the checked fields on the right are
changed to the specified value.

For example, to change all mix icon controls in this State which are currently on MIDI
channel 1 to MIDI channel 3, the above dialog box settings would be used.
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The search may be applied to:
- all of the controls on a given mix icon
- all controls on a given mix form
- all controls in a given state
- all controls in a given scene
- all controls in all scenes and state

The user may do an automated search and replace by clicking the ‘Search and Replace’
button, or the user may do a queried search and replace by clicking the ‘Queried Search
and Replace’ button. This allows the user to view and optionally edit the attributes of a
selected set of controls or of all controls. Often the user will want to do a queried search
without any replacement specified if he wants to edit each matched controls manually, or
simply to review all controls that meet the search criteria.
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When doing a queried search and replace, the user is shown each qualifying control
before any change is made. The user may select ‘Change and Find Next, or ‘Find Next’,
or ‘End Search’.  The user may also hand edit the control to make any desired changes.

View Menu
This menu can also be selected by typing <Alt> then ‘V’.

Disable/Hide All Tool Windows This entry, when clicked, hides all Icon and
VLB windows, the Icon status window,
and the Scenes and States status window if
they are shown. This entry toggles between
hiding the windows and ‘unhiding’ these
windows if they were previously hidden.

Standard Toolbar Brings up the standard application toolbar

Mix Form Tool Bar Brings up the Mix Form Tool Bar (see Mix
Form Tool Bar, page 77 for more
information)

Scene and State Tool Bar Brings up Scene and State Tool Bar

Scene and State Tab Bar Brings up Scene and State Tab Bar

Icon Bars This entry leads to a sub-menu where
individual Icon Bars can be hidden or
shown.
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View Links Allow links between Mix Icons to be
shown.

View Icon Windows … Brings up the VLB Windows selection
dialog and any enabled VLB folders. Mix
Icons are stored as files with the extension
VLB.

View Status Window Brings up Status of Selected Mix Icon
window

View States Window Brings up Scenes and States Window

Show All Hidden Mix Forms Shows all hidden Mix Forms.

Zoom In Zoom in to selected Mix Icon

Zoom Out Zoom out from selected Mix Icon

View Icon Windows …
Mix Icons are stored in files named VLB files. These files are stored in directories. These
directories are shown in the VLB Windows dialog which is shown when the ‘View
Menu->View Icon Windows …’ menu selection is made. All VLB directories are listed
in this dialog and they can be individually selected by <left-clicking> on their names in
this list.

Mix Icons can be moved between these VLB directories by simply clicking and dragging
them from one window to another. A <left-click-and-drag> simply moves the Mix Icon
from one window to another. A <right-click-and-drag> gives the user the option of
moving or copying the selected Mix Icon.

VLB directories can be created by <right-clicking> on the VLB Windows window. By
<right-clicking> on a selected VLB directory, the user can Create, Rename, or Delete that
directory.

By <right-clicking> on a VLB Window, the user can Create a new VLB, Create a new
Window, Delete or Rename this window, or View the VLB Windows Window.

By <right-clicking> on a particular Mix Icon or VLB, the user can Edit, Copy, or Delete
that VLB, or View the VLB Windows Window.
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 Insert Menu
This menu can also be selected by typing <Alt>, then ‘I’.

New Mix Icon Insert new Mix Icon at cursor location

New Mix Form Insert new Mix Form

New State Insert new state

New Scene Insert new scene

New Icon Bar Insert a new and empty Icon Bar
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New Icon Bar
Icon bars can be created by selecting ‘New Icon Bar’ on the Insert menu.

To populate an Icon bar, bring up an Icon window and drag or drop Mix Icons (usually
some form of momentary or toggle switch) on to the bar.

The only Mix Icon coordinates that can be used by a control attached to an icon on the
Icon bar are SwitchToOn, SwitchToOff, MuteOn, MuteOff, SoloOn, and SoloOff. No
positional coordinates are defined in an Icon Bar.

For more information on Icon Bars, see Tool Bars, Tab Bars, and Icon Bars, page 79.

 MIDI Menu
This menu can also be selected by typing <Alt> then ‘M’.

Enable Primary Midi Input Enable/Disable Primary Midi Input if
selected



101

Enable Primary Midi Output Enable/Disable Primary Midi Output if
selected

Enable Secondary Midi Input Enable/Disable Secondary Midi Input if
selected

Enable Secondary Midi Output Enable/Disable Secondary Midi Output if
selected

Select Midi Devices … Bring up Select Midi Devices dialog

Midi Through … Bring up the Midi Through dialog.

See Using MIDI with GraphiMix, page 135, for more information.

This is the Select Midi Devices… dialog. Settings for Primary and Secondary midi ports
can be selected here.
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This is the Midi Through … selections dialog. MIDI through modes for Primary and
Secondary inputs and outputs can be set here.

 Options Menu
This menu can also be selected by typing <Alt> then ‘O’

Icon Size Options This selects the Icon Size Options dialog.

Constraint Options … This selects the Constraint Options dialog.

Link Options … This selects the Link Options dialog.

Attach States To Midi … This selects the Attach States To Midi
dialog.

Icon Size Options
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Check boxes to Allow Small/Medium/Large Icons are provided. The Mix Icons will
change their size dynamically as the Mix Form size is changed. There are 3 sizes
provided for each Mix Icon Image. Some of these choices may be disallowed dependent
on user preferences. For example to force small icons on large Mix Forms, deselect the
Allow Medium and Allow Large Icon checkboxes. A slider is provided on this dialog that
allows the user to set the automatic thresholds for changing the icon sizes to suit
individual preferences.

Constraint Options

Keyboard ‘cursor keys’ can be used to move the selected Mix Icon in addition to the
mouse. These movements may or may not obey the Mix Icon Movement constraints.
There is a checkbox provided to customize this setting.

By checking the ‘Control-Shift drag’ checkbox, the user can permit a <control-shift-
drag> action to temporarily ignore the Mix Icon movement constraints. This could be
used, for example, to reposition a Mix Icon that is set with the Fixed Position movement
constraint.
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Link Options

Mix Icon links can be enabled to be shown in the View Menu. If Mix Icon links are
shown, this dialog box allows the user to select all links to be shown (the default) or only
the links attached to the selected Mix Icon. To show only links attached to the selected
Mix Icon, check this box.

Attach States To Midi Option

GraphiMix can issue a Midi command when the user selects a new State. It can also
change state in response to a received Midi command. This can be used to synchronize
state or scene changes with external equipment or controllers.
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Clicking ‘Next…’ brings up the following dialog.

Any control from any VSL can be specified. A common Midi message used for this
purpose is the Midi ‘Program Change’ command. The dialog above shows the selection
of this control which is available in the PCMidi VSL file. The value that selects States is
zero-based, e.g. State 1 is selected with a value of 0, State 2 is selected with a value of 1,
etc. States are indexed sequentially across Scenes.

 Tools Menu
This menu can also be selected by typing <Alt> then ‘T’.

There are several special tools listed under the ‘Tools’ menu that aid in creating and
customizing the Voyager GraphiMix user and hardware interfaces.

Some of these tools may not be available to all users depending on the version of the
Voyager GraphiMix that was purchased.

Convert Yamaha DME32™ Configuration File Tool
The Yamaha DME32™ is a versatile ‘Mix Engine’ that allows the user to completely
customize the functionality and configuration of this device. The user can graphically add
and connect ‘components’ such as effects and other audio processing as well as filtering
and mixing components to make any configuration that he desires. The Yamaha DME
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Manager™ allows the user to graphically design and wire his custom configuration with
‘click and drag’ operations.

When the configuration is complete, the DME Manager™ can output a parameter file
(PAR file) that assigns a SYSEX parameter change number with individual MIN and
MAX values for each configured control.

In order to generate a PAR file, do the following.
 
1. Select the components you want to include in the .PAR file by selecting or dragging
the mouse over the components on the schematic in the DME Manager. 
 
2. Now, in the DME Manager, print the parameters to a file, which will then be your
.PAR file.  It is ASCII text.

The Voyager Sound GraphiMix Convert DME32 Configuration File tool allows the user
to convert the PAR file output from DME32 Manager™ into a GraphiMix VSL file
automatically. This tool automatically generates SYSEX commands based on the
DME32™ PAR file and stores them in the file, DME32.VSL. If the user makes an
incremental change to the DME configuration, he can simply re-run the tool and the
corresponding new VSL will be generated. If the user is simply adding controls to the
configuration, all original controls will still be valid, and the user will be ‘on the air’ with
the new configuration in seconds. This eliminates the need for the user to reprogram the
MIDI Control Change table every time he makes any changes to the DME configuration.
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The resulting VSL must be placed in the same directory as the other GraphiMix VSL
files ( the VSL subdirectory of the main directory which contains the GraphiMix.EXE
file) to be available to a mix session.

Sample input:
UNIT COMPONENT NO. PARAMETER VALUE MAX MIN
1 4x4 Matrix 0 Fader1 209 255 0

1 OnOff1 1 1 0
2 Solo1 0 1 0

Sample output:
4x4_Matrix:Fader1
! ------ VSL control <c>Voyager Sound Inc 2001 ------------------------------
! Yamaha DME-32 MIDI SYSEX Parameter Change Number <hex>  0
! Parameter Value is set from Mix Icon 'Coordinate'.
   MIN 0
   MAX 255
   PB HF0 H43 # System Exclusive Message and Manufacturer ID
   PN 1   MC  # substatus + midi channel
   PB H3E H05 # group ID (digital mixer)
   PB 0   H30 # byte operation for edit buffer
   PN H0 H0 H0 H0 H0 H0 H0 H0 # Parameter number
   PN H0 ICHH H0 ICHL H0 ICLH H0 ICLL # Parameter Value
   PB HF7     # end of system exclusive
   SN;

4x4_Matrix:Fader1_PR
! ------ VSL control <c>Voyager Sound Inc 2001 ------------------------------
! Yamaha DME-32 MIDI SYSEX Parameter Change Number <hex>  0
! Parameter Value is set from 'Parameter'.
   MIN 0
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   MAX 255
   PB HF0 H43 # System Exclusive Message and Manufacturer ID
   PN 1   MC  # substatus + midi channel
   PB H3E H05 # group ID (digital mixer)
   PB 0   H30 # byte operation for edit buffer
   PN H0 H0 H0 H0 H0 H0 H0 H0 # Parameter number
   PN H0 PRHH H0 PRHL H0 PRLH H0 PRLL # Parameter Value
   PB HF7     # end of system exclusive
   SN;

4x4_Matrix:OnOff1
! ------ VSL control <c>Voyager Sound Inc 2001 ------------------------------
! Yamaha DME-32 MIDI SYSEX Parameter Change Number <hex>  1
! Parameter Value is set from Mix Icon 'Coordinate'.
   MIN 0
   MAX 1
   PB HF0 H43 # System Exclusive Message and Manufacturer ID
   PN 1   MC  # substatus + midi channel
   PB H3E H05 # group ID (digital mixer)
   PB 0   H30 # byte operation for edit buffer
   PN H0 H0 H0 H0 H0 H0 H0 H1 # Parameter number
   PN H0 ICHH H0 ICHL H0 ICLH H0 ICLL # Parameter Value
   PB HF7     # end of system exclusive
   SN;

4x4_Matrix:OnOff1_PR
! ------ VSL control <c>Voyager Sound Inc 2001 ------------------------------
! Yamaha DME-32 MIDI SYSEX Parameter Change Number <hex>  1
! Parameter Value is set from 'Parameter'.
   MIN 0
   MAX 1
   PB HF0 H43 # System Exclusive Message and Manufacturer ID
   PN 1   MC  # substatus + midi channel
   PB H3E H05 # group ID (digital mixer)
   PB 0   H30 # byte operation for edit buffer
   PN H0 H0 H0 H0 H0 H0 H0 H1 # Parameter number
   PN H0 PRHH H0 PRHL H0 PRLH H0 PRLL # Parameter Value
   PB HF7     # end of system exclusive
   SN;

4x4_Matrix:Solo1
! ------ VSL control <c>Voyager Sound Inc 2001 ------------------------------
! Yamaha DME-32 MIDI SYSEX Parameter Change Number <hex>  2
! Parameter Value is set from Mix Icon 'Coordinate'.
   MIN 0
   MAX 1
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   PB HF0 H43 # System Exclusive Message and Manufacturer ID
   PN 1   MC  # substatus + midi channel
   PB H3E H05 # group ID (digital mixer)
   PB 0   H30 # byte operation for edit buffer
   PN H0 H0 H0 H0 H0 H0 H0 H2 # Parameter number
   PN H0 ICHH H0 ICHL H0 ICLH H0 ICLL # Parameter Value
   PB HF7     # end of system exclusive
   SN;

4x4_Matrix:Solo1_PR
! ------ VSL control <c>Voyager Sound Inc 2001 ------------------------------
! Yamaha DME-32 MIDI SYSEX Parameter Change Number <hex>  2
! Parameter Value is set from 'Parameter'.
   MIN 0
   MAX 1
   PB HF0 H43 # System Exclusive Message and Manufacturer ID
   PN 1   MC  # substatus + midi channel
   PB H3E H05 # group ID (digital mixer)
   PB 0   H30 # byte operation for edit buffer
   PN H0 H0 H0 H0 H0 H0 H0 H2 # Parameter number
   PN H0 PRHH H0 PRHL H0 PRLH H0 PRLL # Parameter Value
   PB HF7     # end of system exclusive
   SN;

Note that two VSL controls are added for each DME32 control. This gives the user the
flexibility of programming the DME control with a Mix Icon Coordinate or as a setting in
the ‘Parameter’ field in the Mix Icon Control dialog.

For more information on the VSL language, see Appendix, Voyager System Language
(VSL) Description, page 142.

Edit/Create Mix Icon Images Tool

This tool allows the user to create custom Mix Icons using his own images and custom
settings. These Mix Icons can be used as dynamic controls, or as control labels or
calibration markers. This allows a user to customize the look and appearance of his
graphic interface in an almost unlimited fashion.
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There are several different types of Mix Icons. These types are a Normal Icon, a Toggle
Switch Icon, a Momentary Switch Icon, a Knob Fader Icon, Horizontal and Vertical
Fader Icons, and an Indexed List Icon.

A Normal Icon has four states, Mute On and Off, and Solo On and Off. It passes its Mix
Form coordinates and states to the attached controls.  A Normal Icon can be created from
a standard Windows bitmap file (compressed bitmaps are not yet supported), or as a text-
based Icon with selectable background and foreground colors and fonts. A sample
directory of BMP images is included with the GraphiMix release.

A Switch Icon has two additional internal states, Switch On and Off. Each state may have
its own individual graphic design. There are two different types of switch Icons, a Toggle
switch and a Momentary switch.  A switch Icon adds two additional coordinates to the
Mix Icon Coordinate selection,  ‘SwitchToOn’ and ‘SwitchToOff’. Only one of these
coordinates ‘fire’ at a time depending on the switch state. Controls ‘attached’ to these
coordinates send messages only on the active event.
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Knobs and Fader Mix Icon types have effectively 100 internal states, one for each setting
of the knob or slider. Knobs, horizontal faders and vertical faders can be customized to a
great degree with the built-in menus for this purpose. Knobs and Faders do not take in
windows bitmaps.  A knob or a fader adds two additional coordinates to the Mix Icon
Coordinate selection, ‘Fader’ and ‘Inverse Fader’.

Indexed List Icons display a text string that is read from a text file. This text file with the
extension VTL is a normal text file with one text string per line. The text string displayed
by the icon is indexed by the setting of the coordinate ‘ListIndex’. This is useful when
creating a multi-function switch control, such as a signal router. Indexed List Icons do not
use windows bitmaps.

Creating Normal Icons
To create or edit a Normal Mix Icon, select the Tools Menu->Edit/Create Mix Icon
dialog.

To create a new icon, click on the Create Icon button at the top right. To copy and modify
an existing Icon, select the icon to be copied from the image menu at the left, and click on
the Copy Icon button (under the Create Icon button).

There are 3 sets of images shown, the Normal Images, the Bright Images, and the Dim
Images. The Normal image is the image displayed when the Icon is in active use. The
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Dim image is displayed when the Mix Icon is disabled or Muted. The Bright image is
displayed when the Mix Icon is in ‘Solo Mode’.

There are 3 sizes for each type of image provided for a total of 9 images. These different
sizes are used to scale the Mix Icon image to the size of the Mix Form. For example, if an
icon is placed on a Mix Form, and then the Mix Form is shrunk by ‘grabbing’ a corner of
the Mix Form with the mouse and adjusting the size smaller, the Mix Icon will shift to a
smaller image to fit.  There are 3 sizes provided to accommodate both large and small
Mix Forms. The threshold for the size adjustment is adjustable under the Options Menu.
Additionally, each of the three sizes can be specifically disabled with this menu.

One way to specify the look of a Mix Icon is to import a windows bitmap file (BMP).
Each individual image (of the 9) may be selected and individually assigned to a BMP. If
an image is selected and assigned, the same image will ‘inherit’ across all the other
images and variations which haven’t been assigned to a BMP or Text Icon. A sample
directory of BMP images is included with the GraphiMix release.

The Bright image default is automatically created by putting a light green border around
all transparent-to-nontransparent  borders. The Dim Image default is automatically
created by setting every other pixel to transparent.

If all images have been assigned, the user can still change any one image in particular by
selecting it and using the ‘Assign BMP’ or ‘Assign TEXT’ buttons. To remove a
particular image, once assigned, click on the ‘Remove BMP’ button. This allows it to
‘inherit’ images again. If an image is ‘unfilled’, it will display as a light green square.

Text can be assigned instead of a BMP. The Text color and font can be selected as can
the background color.

If the background color of the BMP or text is set to pure black (RGB=0,0,0) or pure
white (RGB = 255,255,255) these areas can be made transparent by selecting the
‘Transparency Mode’ dropdown list at the bottom right of the dialog. The choices are
Black to Transparent, White to Transparent, No Transparency.
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Creating Text Icon Images

To create a Text Icon Image, select the image (of the 9) that you wish to assign text to,
and then click on the ‘Assign TEXT’ button. The ‘Edit Text Based Image’ dialog box
will appear.

Choose a font and set a background color. Pure black or pure white can be turned into
transparent background in the main dialog.
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Click inside the square and type the centered text into the text entry box.

Click ‘OK’ when done and return to the main dialog. Select the transparency mode and
enter an optional name or description for this Mix Icon.  The ‘name or description’ field
is used to generate tool tips for mix icon images. When the cursor rests over a mix icon
image in the icon image selection window, a tool tip will be generated. The tool tip will
be the description entered, if one exists, or will be the type of mix icon, such as ‘Toggle
Switch’, if no description was entered.
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Click on ‘OK’ when finished and save the VLB file.
Your new Mix Icon now appears in the Mix Icon Selection Window. To use this icon in a
mix, <right-click> and drag the new icon from the selection window to your Mix Form.

Note the transparent background.

Creating Mix Icon Images from BMP files
Windows bitmap files (BMP’s) can be used to fill any or all of the Mix Icon Images.
Select the image to be filled and click on the ‘Assign BMP’  button. An Open File dialog
will appear. Navigate to the BMP file to use. Click ‘Open’ to select the file. A sample
directory of BMP images is included with the GraphiMix release.

The large icon is a 64X64 pixel square. The middle icon is 32X32, and the smallest is
16X16.  Monochrome, 16 color,  256 color, and 24 bit color bitmap formats are
supported. Compressed bitmap formats are not currently supported. Any size BMP can be
read in. It is automatically scaled to the proper size.

All images are automatically converted to the Voyager 256 color palette. The GraphiMix
palette is a ‘web-compatible palette’ with a few special entries. All BMP’s are converted
to the nearest palette entry as they are read in. For this reason, there may be slight color
differences between the Mix Icon Image and the original BMP.

Switch Icon Creation
Switch Mix Icons have an additional two states, an ON state and an OFF state. Switches
may be momentary or toggle type switches. A momentary switch is ON when the mouse
button is depressed and OFF when the button is released. A toggle switch can be either
ON or OFF and toggles between these two states when the mouse button is clicked.

To change the state of a switch, the <control> key on the keyboard must be held down
when the left mouse button is depressed. Switch Mix Icons also have a ‘Toggle Switch on
Left Click’ checkbox in the Mix Icon Properties dialog. If this is checked, the <control>
key does not have to be depressed to toggle the switch. A simple <left-click> will then
toggle the switch. A mouse <left click-and-drag> on this icon will be disabled when in
this mode.
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Each state of a switch has 9 associated images, identical to a normal icon image, for a
total of 18 images. All of these images can be individually specified for each state.

This is an example of the dialog for the Switch On state.
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This is the Switch Off state.

Knob Icon Creation
The Knob Icon is a complex Mix Icon type. Because of the very large number of image
states (100), the image is captured at runtime, from the control itself. A significant
difference from the other Mix Icon types is that there is only one image size for each
Knob and Fader Mix Icon. The Knob and Fader icons can be customized to be large or
small with the Create Icon Image Tool, but the resulting Mix Icons do not automatically
scale with the Mix Form size. Both Horizontal and Vertical Faders (but not Knobs) can
be sized to be a fraction of the Mix Form size so that these will scale exactly (instead of 3
different sizes). The designer of the Mix Session must take this into account when
designing the Mix Forms and the session layout.

To change the state of a Knob Mix Icon, hold down the keyboard <control> key and then
‘click-and-drag’ the rotary knob  at the knob pointer or index. To position the Knob Mix
Icon on the Mix Form, click-and-drag without the <control> key depressed. The
<control> key therefore determines whether the mouse commands go to the position of
the Mix Icon on the Mix Form, or to the setting of the Mix Icon knob.

The use of the <control> key can be avoided if the ‘Left Click Adjusts Fader Value’
checkbox in the Mix Icon Properties dialog is checked. When in this mode, the <control>
key does not have to be depressed. A simple <left-click-and-drag> will then operate the
knob. The position of the Knob Icon is fixed on the Mix Form when in this mode.
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The image of Knob Mix Icon can be easily customized. To Edit or create a Knob Mix
Icon, select the Mix Icon type drop down list to ‘Knob Type Fader’. Then click on the
Edit Knob button. Note that only the central portion of a Knob or a Fader Icon Image is
shown in the Icon Image Selection window to the left of the main dialog as well as in the
Mix Icon Selection window. These Mix Icons types will be full size when placed on a
Mix Form.
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The following dialog shows all the parameters that affect the appearance of a Knob Mix
Icon. The Knob Mix Icon is the only type, at the current time, that supports tick mark
Captions.

Each caption is entered on a separate line in the Captions text box. Use <control-Enter >
to add a new line within this text box. Use the keyboard arrow keys to navigate around
this text box.

Fader Icon Creation
The Fader Icon is a complex Mix Icon type. Because of the very large number of image
states (100), the image is generated at run time. Unlike the Knob, Fader Mix Icons can be
set to ‘scale’ their size to a fraction of the Mix Form size. If this is selected, the Fader
Mix Icons will change their size as the Mix Form size is adjusted to be a constant,
selectable fraction of the Mix Form size. This is set in the Mix Icon Properties dialog for
the Fader Mix Icon.

To change the state of a Fader Mix Icon, hold down the keyboard <control> key and then
‘click-and-drag’ the fader slider. To position the Fader Mix Icon on the Mix Form, click-
and-drag without the <control> key depressed. The <control> key therefore determines
whether the mouse commands go to the position of the Mix Icon on the Mix Form, or to
the setting of the Mix Icon slider.

The use of the <control> key can be avoided if the ‘Left Click Adjusts Fader Value’
checkbox in the Mix Icon Properties dialog is checked. When in this mode, the <control>
key does not have to be depressed. A simple <left-click-and-drag> will then operate the
fader. The position of the Fader Icon is fixed on the Mix Form when in this mode.
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The image of a Fader Mix Icon can be easily customized. To edit or create a Fader Mix
Icon, select the Mix Icon type drop down list to ‘Vertical Fader’ or ‘Horizontal Fader’.
Then click on the Edit Fader button.

This dialog shows all the parameters that affect the appearance of a Fader Mix Icon. The
Fader Mix Icon does not support captions at the current time.



121

Indexed List Icon Creation
The user can create an Indexed List icon by using the Edit/Create Icon Tool available on
the Tools menu and selecting ‘Indexed List’ as the icon type.

These icons can have different widths, set in the Edit List Icon Properties dialog.

The VTL file is a normal text file with a text string on each line. The icon displays the
text string out of this file that is indexed by the ListIndex coordinate in the Mix Icon
Control Properties dialog.
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Here is an example of a VTL list shown in Notepad.

Window Menu
This Menu allows the user to Cascade or Tile Mix Forms on the screen. This menu can
also be selected by typing <Alt> then ‘W’. This menu controls the display of Mix Forms
according to their individual Mix Form display modes. These modes are set in the Mix
Form context menu (<right-click> on the Mix Form background).

Cascade Arrange all non-hidden, non-minimized,
Mix Forms in this state in an overlapping,
cascaded fashion.

Tile Arrange all non-hidden, non-minimized,
Mix Forms in this state in an abutting, tiled
fashion.

Always Stay Tiled This sets all visible Mix Forms into the
Tiled Mix Form Display Mode

Add Tiled Column Selecting this entry adds another column to
the Tiled Mix Form Display. Mix Forms
can be dragged and dropped on to the new
column to populate it.
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Bring Non-Tiled To Front Mix Forms that are visible but are not tiled
can be displayed ‘behind’ the tiled Mix
Form display. To bring these to the front,
click on this entry.
The Standard Tool Bar also has a ‘Bring
To Front’ button for easy access.

Send Non-Tiled To Back Mix Forms that are visible but do not have
the ‘OK to Tile’ checkbox set can be
displayed ‘behind’ the tiled Mix Form
display. To send these to the back, click on
this entry.

Show All Hidden Mix Forms ‘Un-Hide’ all hidden Mix Forms.

MixForms… List of all Mix Forms in the current State.

Tiled Mix Form Display Mode
This is a useful feature that allows the user to most efficiently use and access the
GraphiMix mix surface. Most template sessions use this mode for the most frequently
accessed Mix Forms.
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This mode is accessed from the Window menu in GraphiMix.

A Mix Form can be a free-floating window of any size (inside the GraphiMix
mainframe), or it can be hidden, or it can be minimized, or it can be tiled. A tiled Mix
Form shares and fully occupies the GraphiMix application window frame with all other
tiled Mix Forms.
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By clicking and dragging on a side or top or bottom of a mix form that is tiled, the user
can change the size of the selected mix form and all other tiled mix forms will then re-
adjust their edges to fit the new size.
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When the mix form is released, the columns will readjust to accommodate the new size.
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There is a minimum column width and a minimum Mix Form height within a column.
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A Mix Form that is ‘rolled up’ to its minimum height or its minimum width is ‘sticky’ in
the sense that it will tend to stay minimized when the tiling is adjusted. For example, in
the following image, there is a stack of mix forms in the rightmost column with only two
mix forms ‘open’ and the rest ‘rolled-up’ to their minimum height.

If the ‘Aux Bus’ Mix Form height is resized, the ‘Virtual Mains’ Mix Form will change
its height in return. All of the other Mix Forms in that column will remain ‘rolled-up’.
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The same behavior will occur when the widths are adjusted.



130

To move Mix Forms from column to column or to a different place in the same column,
simply drag the selected Mix Form (use the title bar) to the new position and release it. It
will automatically retile into the appropriate place.
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Help Menu
This menu can also be selected by typing <Alt> then ‘H’.

Registration … Registration dialog.
Select this dialog to input required and
optional information to register your copy
of the Voyager GraphiMix and obtain a
valid license number.

License … Licensing dialog.
Select this dialog to input the licensing
information obtained from Voyager Sound
Inc to enable all appropriate features.

About GraphiMix … Select this entry to view the Voyager
GraphiMix version and revision
information.



132

Loaded Help Files … Depending on the version of GraphiMix
and the Mixer ‘packages’ available, there
will be one or more help files available
here. All versions of GraphiMix will have
the GRAPHIMIX.HLP file loaded here.
Other HLP files, such as
GraphiMixForSonarUsers, will optionally
be displayed here. Click on one to select it
and run the help utility.
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MIDI
The Voyager GraphiMix System can send and receive MIDI commands to control and be
controlled by other MIDI applications and hardware. GraphiMix sends and receives these
commands by way of MIDI devices or ports. These devices/ports are set in the “Midi
Menu->Select Midi Devices…” menu.

Received MIDI commands are processed and matched up to specific controls, based on
their individual settings, to cause movement of the appropriate Mix Icons.

Movement of a Mix Icon, caused by the dragging it with the mouse for example, causes
each Mix Icon’s attached controls to output MIDI messages dependent on the settings in
the Mix Icon Properties->Controls tab.

If a message is received by a Mix Icon from an external source, the sending of an
identical message based on its new position is inhibited for a short time. Similarly, if the
movement of a Mix Icon (by a mouse or keyboard) causes MIDI to be sent, then than the
movement in response to a received MIDI message is inhibited for a short time (the
CCSST time). This is done primarily to prevent MIDI feedback from a device that echoes
all received commands.

One of the best WEB based sources for MIDI documentation is http://www.harmony-
central.com/MIDI/Doc/

A basic understanding of MIDI is essential for effective use of the Voyager GraphiMix
System.

What is MIDI?
The Musical Instrument Digital Interface (MIDI) was invented in the early 1980’s by a
group of synthesizer manufacturers as a way to connect instruments together to make
sound. Since then it has evolved into the protocol of choice for controlling everything
from sound synthesizers to tape machines.

MIDI is simply a communications protocol consisting of messages that consist of as few
as 1 byte and up to thousands of bytes. For external hardware, a MIDI port runs at 31250
baud. Since each byte is a 10 bit sequence in this protocol (eight data bits + two stop
bits), 3125 bytes can be sent each second.

Each MIDI message contains a single status byte and zero or more data bytes. All status
bytes are in the range of 128-255 and all data bytes are in the range of 0-127. This allows
easy identification of status and data bytes. This also limits data in a single byte of a
MIDI message to 7 bits.  The lower 4 bits of the status byte hold the MIDI channel (1-16)
which is encoded as the values 0-15. The upper 4 bits of the status byte hold the type of
the MIDI message.
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The most common type of data sent using MIDI is the Channel message. There are 7
types of Channel messages, each having one or two associated data bytes. These message
types are shown in the following table.

Status Byte (hex) Data 1 Data 2 Message type
0x8n
(n = MIDI channel
number <0-15> )

Note Velocity Note Off

0x9n Note Velocity Note On
0xAn Note Pressure Key Aftertouch
0xBn Control # Value Control Change
0xCn Program # Program Change
0xDn Pressure Channel Aftertouch
0xEn LSB MSB Pitch Bend
0xF0 (SYSEX data) (SYSEX data) System Exclusive

System Exclusive (SYSEX) MIDI messages can be of arbitrary length. The value of the
status byte of a SYSEX message is 240 (0xF0) and the final data byte in the message is a
247 (0xF7). SYSEX message were originally used to transfer blocks of data, sometimes
consisting of thousands of bytes.  These blocks of data would specify complete setups of
all the controls on a mixer, or settings or patches for MIDI musical synthesizers.

Recently console manufactures have been utilizing this form of message to encode
parameter changes using relatively short (12 bytes or so) messages.  SYSEX messages
can also be of variable length, allowing the device to compactly specify the settings for
multiple adjacent controls in a single SYSEX message.

Control Change messages used to control devices can become quite complex and the
setting of a single control can involve a series of 3 byte Control Change messages with
optional and defaulted sub-messages.

GraphiMix supports all known MIDI message protocols using the Voyager Sound VSL
protocol description language.

The Voyager GraphiMix most commonly makes use of the MIDI Control Change and
Program Change messages to control mix hardware. SYSEX is used as well in some
cases if the manufacturer uses this form of MIDI message to communicate with some or
all of his hardware.  The MIDI Theremin demo utilizes most of the above listed message
types to create sounds using the PC MIDI synthesizer included in most PC’s.

MIDI Devices

GraphiMix (and other applications such as sequencers) receive MIDI messages from and
output MIDI messages to MIDI devices. These devices may do something in response to
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MIDI, or they may just act as a ‘connection’ to pass MIDI from one application to
another. These devices may also be known as MIDI ports as they port data in to or out of
an application.

MIDI Synthesizers
MIDI Synthesizers produce sound in response to MIDI messages. Most common PC’s
have a sound card with a built-in MIDI synthesizer. The name of this synthesizer device
often has the word SYNTH in it or you may use the MICROSOFT GS WAVETABLE if
it exists. External Midi Synthesizers are available and usually provide much better sound
quality and a larger range of available sounds or voices.

External MIDI Ports
A PC communicates with external MIDI hardware using one or more external MIDI
ports. Most sound cards (they may need an adapter cable) will provide at least one MIDI
port (one input and one output). Other devices are available that can provide more MIDI
ports via USB or Firewire, or by plugging into a PCI card slot or PCMCIA port.

GraphiPorts
GraphiPorts are in-memory MIDI ports that provide MIDI communications between
Voyager Sound applications such as GraphiMix, GraphiSeq, and GraphiSpy and the
Cakewalk SONAR plug-in, GraphiSon. These special MIDI ports do not use the PC’s
MIDI resources and do not count against the total number of MIDI ports that a PC can
support.

GraphiPorts can only have a single sender and a single receiver.

MIDI-YOKE™ Ports
A useful utility which enables software MIDI applications like GraphiMix to
communicate with other MIDI applications within the computer is MIDI YOKE™. This
utility is available from a company called MIDIOX™.  MIDI YOKE™ is included in the
GraphiMix installation and can optionally be installed by the user. We recommend
visiting their site at  http://www.midiox.com. This program installs a series of MIDI I/O
ports which show up as MIDI devices.  For instance, to send MIDI data from GraphiMix
to a MIDI sequencer, select 'YOKE1' as an output for GraphiMix , then select 'YOKE1'
as a MIDI input for your software sequencer.  When the sequencer is directed to record, it
will capture the MIDI data sent from the GraphiMix program. You can send data back to
GraphiMix via 'YOKE2'. Set your sequencer to output its MIDI data on 'YOKE2' and set
GraphiMix to receive on 'YOKE2'

MIDI-Yoke ports can have multiple receivers, i.e. A sequencer could output on a MIDI
YOKE port and both GraphiMix and GraphiSpy could receive the data.

Using MIDI with GraphiMix
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GraphiMix supports two sets of MIDI devices, the Primary set and the Secondary set.
These are identical and provide the ability to send and receive from two different MIDI
devices.

This menu is obtained by selecting the Midi Menu->Select Midi Device entry.

When this dialog is selected, it should show all the available MIDI devices on the user’s
computer for Input and Output. To enable GraphiMix to output MIDI based on the
position of a Mix Icon and its attached controls, select the appropriate Output Device. If
MIDI is being sent to external MIDI hardware (such as a MIDI mixer), select the
External or UART setting. If the MIDI messages are being sent to a software application
(such as a MIDI sequencer) then the Output device will likely be a software MIDI port
such as a MIDI YOKE™ port.

Similarly, to receive MIDI messages from an application or device, select the appropriate
Input device such as the External device or UART if it is an external hardware device, or
a MIDI YOKE™ port, if it is from another application.

Any MIDI messages that are not attached to controls are discarded if they are received.
System Exclusive messages (SYSEX) are fully supported.

The CCSST (Control Change Source Standoff Timer)

The GraphiMix system incorporates the notion of the Control Change ‘Source’. A
Control Change event (not to be confused with a MIDI Control Change message) is
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anything that causes the Mix Icon to change state. A control change can be caused either
by Mix Icon movement on the Mix Form or a change in its internal state (like a switch for
example). The source of these changes can be ‘internal’ to GraphiMix caused by the
mouse or the keyboard, or MIDI received from an external source. The Control Change
Source refers to the last source of changes for this particular Mix Icon that actually
caused a change.

GraphiMix has a built in delay for each Mix Icon called the CCSST (Control Change
Source Standoff Timer) during which time it will ignore control changes coming from a
different source than the source that moved it previously for a given Mix Icon. The
CCSST timer can be set in the Edit Menu->Preferences->Timing dialog.

The CCSST time needs to be set long enough to transfer all controls’ MIDI messages to
the target hardware on a scene or state change, otherwise echoed messages may ‘push
back’ on the icon movements. The more controls that are in a particular state, the larger
this number has to be. This number also has to be set larger if external MIDI is used
rather then GraphiPorts because of the slower data rate. Setting this to a large delay is
only a problem if the user is using both the external hardware/application and GraphiMix
to set the same control; the user then must wait this amount of time before switching
which surface he is using.

For example, If GraphiMix was set to input MIDI control changes from an external
hardware mixer, and to output MIDI messages to the same external hardware mixer, a
legal configuration, then one could move the Mix Icons by moving faders on the
hardware mixer and subsequently move the external faders by moving the Mix Icons with
a mouse. This will work, but to avoid feedback from the external mixer, GraphiMix will
ignore messages from the mixer while its Mix Icons are being moved with the mouse and
for a short time (the CCSST timeout) after the messages stop. This assumes that the user
is either using the controls on the hardware mixer to do the mix or he is using GraphiMix
to control the hardware mixer at any one time. The user cannot have a hand on the same
control on both at the same time. He can, however, alternate between using the console
and using GraphiMix as long as he waits for the CCSST timeout time before choosing a
different mix surface.

MIDI Sequencers
You can use a MIDI sequencer to record and play back MIDI data including control
change commands from the GraphiMix.  GraphiMix can be set up to output MIDI to the
sequencer (usually through a MIDIYOKE™ port or equivalent) and to respond to control
change MIDI messages on playback by receiving MIDI. For example, the secondary set
of MIDI Devices supported by GraphiMix can be used to ‘connect’ to a sequencer, while
the primary set would be connected to the target console.

MIDI Through
GraphiMix now supports MIDI Through mode. Each MIDI input port (primary or
secondary) can be independently set to echo its data to either MIDI output. This is useful
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when a MIDI sequencer is being used to record and play back control changes sent to a
Mix console.

For example, to use a sequencer to record and play back with GraphiMix while it is also
connected to a mix console, connect the mix console to MIDI input and output using the
GraphiMix primary ports and connect the sequencer to MIDI input and output using the
GraphiMix secondary ports. Now set the MIDI Through selections as shown above, i.e.
Primary Input to Secondary Output and Secondary Input to Primary Output. Now, control
changes made in GraphiMix or on the target mix console will be recorded with the
sequencer. When the sequencer is played back, the MIDI sequences will be sent to both
GraphiMix and to the target console. In this case, turn off MIDI Through on the target
console and on the sequencer, otherwise, a MIDI feedback loop may result.

It is possible to create MIDI feedback loops by connecting the inputs and outputs of
applications and GraphiMix in a configuration which may result in improper or
intermittent behavior. GraphiMix attempts to prevent these loops by inhibiting the re-
sending of messages it has received, but the MIDI Through messages have no such
restriction.

System Exclusive (SYSEX)
GraphiMix does fully support the input and output of MIDI System Exclusive messages.
GraphiMix also supports SYSEX VSL templates which enables it to respond to variable
length SYSEX messages.

Control Change Messages
In recent years, there has been an effort to extend the complexity of MIDI Control
Change Messages to protocols that support 14 bit controllers, defaulted parameters,
increment/decrement controllers, and others. GraphiMix fully supports all known Control
Change message protocols.
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GraphiMix Files

VOY Files
Each mix session can be saved to a named file with the extension '.voy' by using the File
Menu->Save or Save As selections. VOY files can be also loaded in to the GraphiMix
system by using the File Menu->Open selection. A GraphiMix session can also be started
by double-clicking on the VOY file. These VOY files can be in any directory, but by
default, are saved in the VOY subdirectory of the GraphiMix root directory.

The VOY file is a proprietary Voyager data file which is capable of storing an entire
GraphiMix session.

VSL Files
Each hardware control that is useable by the GraphiMix system must be defined in a
named file with the extension '.vsl’. The VSL file contains information about that control
including a message protocol. Typically, each controllable device that is connected to the
PC running the Voyager Sound GraphiMix system will have at least one VSL file in the
VSL subdirectory of the GraphiMix root directory.

Small VSL Files with up to 32 controls can be created and used by the engineer.  Any
number of small VSL files may be created. Larger, production VSL’s, require a
checksum that can only be created by Voyager Sound Inc. Currently, these production
VSL files are only available from Voyager Sound Inc. Please contact us (see Contact
Information, page 176) for requests and available updates.

VLB Files
Each Mix Icon’s image and default data structures are contained in a named file with the
extension '.vlb’. These VLB files are contained in the VLB subdirectory of the
GraphiMix root directory or in named subdirectories of this directory.

When the View menu->View Icon Windows.. entry is selected, all VLB’s that are shown
in the VLBs Primary window reside in the VLB subdirectory. All other windows exist as
subdirectories to the VLB subdirectory.

VXP Files
Any particular mix session can incorporate custom Mix Icons, custom VSL files, and
other custom files that the user has created. This can create a problem when the engineer
has to move the GraphiMix session to another PC. He has to copy the VOY files and any
other custom files and then put them in all the correct places on the new PC.

To simplify this process, the user can select Export Environment… from the File Menu to
export all files associated with a particular mix session (except for the VOY file itself).
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This essentially exports the mix session environment to a named file with the extension
‘.vxp’.

In order to ‘move’ a mix session and environment, the engineer has to copy the VOY file
and the VXP file to the new PC. By selecting File Menu->Import Environment he can
replicate his GraphiMix environment and then he can load the copied VOY file into
GraphiMix. The user may have to re-select the MIDI input and output devices, depending
on the new hardware configuration.

For more information see the File Menu, Export Environment…, page 83, and Import
Environment…, page 84.

VTL Files
The Indexed List Mix Icon uses a text file with the extension ‘.vtl’ to hold the text strings
that it will display based on the value of the Mix Icon coordinate ListIndex. Each text
string is on a single line of the VTL file. The Indexed List Mix Icon uses the value of
ListIndex to index into this VTL file to select the appropriate text string to display.

TAG Files
Weecon and Tag sequences are stored in named files with the extension ‘.tag’. These files
reside in the TAG subdirectory of the GraphiMix root directory.

BMP Files
Windows bitmap files are named files with the extension ‘.bmp’. These files hold images
that can be created by various windows applications such as MSPAINT. The BMP
subdirectory of the GraphiMix main directory holds miscellaneous BMP files for the user
to use for custom Mix Icons if he so desires.

DLL Files
Windows DLL files are dynamically linked library files that provide a plug-in capability
to extend the feature set of applications. GraphiMix uses many DLL’s during its normal
operation on a Windows PC. Voyager Sound also provides a plug-in, GraphiSon.DLL,
for Cakewalk’s SONAR digital audio workstation application which allows it to
communicate with GraphiMix.

CHM Files
Compiled HTML files are named files with the extension ‘.chm’. The GraphiSon.chm
file provides a hyper-linked help file for the plug-in for Cakewalk’s SONAR application.
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GraphiMix Support Packages
Various Mix hardware support packages are included with the GraphiMix. Each support
package includes one or more VSL files which contain the messages used to
communicate with the hardware as well as one or more template session (VOY) files that
provide initial setups and controls to use with the target hardware. Detailed
documentation is also provided in each support package.

Voyager Sound will be continuing to add support for new mix hardware as development
proceeds. Licensed users of the GraphiMix are entitled to free updates for one year after
purchase. Updates may include fixes and new features as well as new support packages
as they become available. Please check our web site <VoyagerSound.com> for
announcements and availability of updates.
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Appendix

 Voyager System Language (VSL) Description
VSL files contain the ‘recipes’ to allow GraphiMix to construct the proper message
packet to send to the hardware control.

Most often, these recipes are printed in the back of the manual for the equipment to be
controlled.

These recipes usually involve a byte-by-byte or even nibble-by-nibble description of the
message to be sent.  Certain nibbles are the message type, others are the MIDI channel, or
a constant representing the address or number of the control to be changed. The values
can be a single (7 bit) byte or 2 (7 bit) bytes, or spread out over several bytes a nibble at a
time.

Some of these recipes can be quite complex in their description.

Voyager designed the VSL language to handle all of these diverse descriptions and
requirements to compactly encode these message formats in a form that can be used by
GraphiMix.

This VSL language is written as text so it can be read and written with text editors such
as Notepad™. There is a checksum appended to the file that is required to match the VSL
text if the numbers of controls in the file exceeds 32 controls. At present, only Voyager
Sound can create this checksum. This is to insure quality control on the production
version of these files and to implement licensing level constraints. The user can write any
number of VSL files with 32 or fewer controls for custom needs. The checksum is not
required for these small VSL files.

The GraphiSpy application included with this release, or the MIDI-OX™ application,
available from a download on the Voyager Sound web site, are very useful in debugging
VSL files and control messages.

VSL Control Format

The following is an example of a VSL entry for a single control.
# -------------- Control Change Table (register mode) -----------------
Ch1:InputLevel
                 ! MIDI Control Change message (Register Mode) --------
                 !  Bank:0 Control:0 Input1 Level control
                 !  Value is set from Mix Icon 'Coordinate'.
                 !  Midi Channel is set in 'MIDI Channel'  <1 - 16>.
                 MIN 0
                 MAX 127
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                 PC MIDI
                 PN HB  # push nibble hex B == Control Change
                    MC  # push nibble as MIDI Channel
                   6 2  # H62 specifies NRPN (a MIDI flag indicating
                        # 'bank')
                   0 0  # bank 0
                    HB  # push nibble hex B == Control Change
                    MC  # push nibble as MIDI Channel
                 PB 00  # push control number as byte
                    IC  # push data value <0-127>
                    SN  # send it now
                     ;  # done with record

This is another example.

NoteOn PN H9 MC PB IC PR SN;

The VSL Control Recipe entry consists of a series of tokens, starting with a control name
and terminating with a ‘;’.  Individual tokens are terminated with ‘white space’ (spaces,
tabs, return, linefeeds).

Many of the tokens have both long names and shortcuts.
For example, you can type 'PUSHNIBBLE' or you can type 'PN'.
Most developers will quickly learn to use the shortcuts.

Comments Token
The comment character is a ‘#’. Everything from a ‘#’ to the end of the line is considered
a comment. There are two ‘null’ characters ‘[‘ and ‘]’, that have no effect other than to
enhance readability.

Control Name Token
A VSL Control Recipe entry starts with the control name. A control name string consists
of an optional <component +’:’> followed by the <control name>. The control name
string should be unique. If another identically named control is encountered in the same
VSL file it will be replaced. In the first example above, the control component is ‘Ch1’
and the control name is ‘InputLevel’. In the second example, the control name is
‘NoteOn’.  If no Component is specified, the name <default> will be shown in the
component box in the Mix Icon Properties dialog.  Control names can consist of numbers
and letters and the characters ‘-‘, ‘<’, ‘>’, and ‘_’.  White space (tabs, spaces, return,
linefeed)  terminates a control name string.

Description Token
The description token is begun with a ‘!’ and runs to the end of the line. Several
description lines may be included. The description is displayed in the Mix Icon Properties
Controls tab when the control is specified by the selection of the VSL file, the component
and the control name fields in this dialog.
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MIN and MAX Tokens
The MIN and the MAX tokens are followed by a value token that specifies the control’s
Minimum and Maximum legal values. The minimum defaults to 0 and the maximum
defaults to 127 if these values are not specified. These values can specify multi-byte
limits, for example a 14 bit value could have 16383 set as the MAX. These values only
apply to the Mix Icon Coordinate value and the assigned Data Type. They do not apply to
values set in other fields such as the Index, Parameter, or Program fields.

These MIN and MAX values set in the VSL file can be overridden by the user in the Mix
Icon Properties Controls tab. These values are saved in the VOY session file.

Protocol Token
The Protocol token (PROTOCOL or PC) specifies the message protocol. For this release,
the only valid protocols are MIDI and INTERNAL. For MIDI applications, the protocol
should be set to MIDI. This token defaults to MIDI if not specified. The INTERNAL
protocol is used to set variables inside the GraphiMix. These variables currently specify
the algorithm settings for deriving the complex control data types used for surround
sound-fader operation. For more information on these data types see Mix Icon Properties,
page 54. For more description of these internal protocols and message types see
GraphiMix Internal Variables and Commands, page 159.

PUSH Data Operators
A Control message consists of a series of data bytes that is output to some device using
some particular hardware protocol, for example MIDI. This is implemented within
Voyager as a series of data values of 4, 8, or 16-bit widths that are ‘pushed’ onto the
output stream and sent to the device in order.

These control message values are implemented by the PUSHNIBBLE (PN), PUSHBYTE
(PB), and PUSHWORD (PW) tokens.

The PUSHNIBBLE, PUSHBYTE and PUSHWORD tokens are sticky in the sense that
once they are specified, they apply to all data that immediately follows without any
intervening other commands.  Once a PN, PB, or PW command has been given, all future
numerical data will be assumed to also be pushed as a nibble, byte, or a word until the
first non-numeric item is encountered or until a new push command is encountered. This
prevents the developer from having to type PN (for example) repeatedly.

Decimal values are entered directly. Hexadecimal values are given by putting an H before
the number as in H30 or H3AC.

Calculations are started with an open parenthesis character '(' and terminated by a ')'.

The file format is case insensitive.

For example the strings 'PN 9 PN 8 PN 7 PN 6' is equivalent to
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 'PN 9 8 7 6'.

A 'PW H9876' is equivalent to 'PB H98 H76' is equivalent to 'PN H9 H8 H7 H6'

Control Value Tokens
Data values in the VSL control recipe can also be dynamic values, derived from the
position of the Mix Icon on the Mix Form. This is what allows the movement of a Mix
Icon to send messages to an attached hardware mixer to change a fader value (for
instance).  The icon’s positional information is available in the ICONDATA (derived
from the assigned Coordinate and the Data Type), as well as the ICONRADIUS,
ICONTHETA, ICONX, and ICONY variables.

Some of these values are variables set in a entry box in the Mix Icon Properties Controls
dialog. These variables are the MIDICHAN <MC>,   PARAMDATA <PR>,
PROGRAM <PG>, and INDEX <IX>.

ICONDATA, <IC>, is derived from the assigned Data Type and Coordinate, and the
MIN and MAX values. The Data Type selects the positional mapping algorithm, 0-based
mapping (fader) or center-based mapping (panpot). Other Data Types are for complex
Stereo and Surround control of fader input-by-output matrix configurations. The
Coordinate field selects which of the Mix Icon Coordinates the control will be ‘attached’
to.

ICONRADIUS, <RD>, is the Mix Icon Radius, (127 at boundary radius, 0 at Mix
Origin).

ICONTHETA, <TH>, is the Mix Icon Theta (theta 0, left -> 127, right).

ICONX, <PX>, is the absolute value of the Mix Icon’s X position (0 = center, 127 =
left/right (same as fader))

ICONY, <PY>, is the absolute value of the Mix Icon’s Y position (0 = center/origin, 127
= top/bottom (same as fader))

MIDICHAN,  <MC>, which takes the value of the ‘MIDI Channel’ (1-16) dialog box and
subtracts 1 (yielding 0-15).  This is the only field that modifies the value set by the user
by subtracting 1.

PARAMDATA, <PR>, is the value set in the ‘Parameter’ dialog box in the Mix Icon
Properties Controls tab.

PROGRAM, <PG>, is the value set in the ‘Program’ dialog box in the Mix Icon
Properties Controls tab.
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INDEX, <IX> , is the value set in the ‘Index’ dialog box in the Mix Icon Properties
Controls tab.

Complete list of Control Value tokens.

Control Value Token Token shortcut Description
MIDICHAN MC MIDI channel number
INDEX IX Control Index Value
INDEXH IXH Control Index Value – High

byte
INDEXL IXL Control Index Value – Low

byte
INDEX14H IX14H Control Index Value – High

<7bits>
INDEX14L IX14L Control Index Value – Low

<7bits>
INDEXHH IXHH Control Index Value – High

byte, High Nibble
INDEXHL IXHL Control Index Value – High

byte, Low Nibble
INDEXLH IXLH Control Index Value – Low

byte, High Nibble
INDEXLL IXLL Control Index Value – Low

byte, Low Nibble
ICONDATA IC Control Mix Icon Value

determined by Data Type
and Coordinate selection

ICONDATAH ICH Control Mix Icon Value –
High byte

ICONDATAL ICL Control Mix Icon Value –
Low byte

ICONDATA14H IC14H Control Mix Icon Value –
High <7bits>

ICONDATA14L IC14L Control Mix Icon Value –
Low <7bits>

ICONDATAHH ICHH Control Mix Icon Value –
High byte, High nibble

ICONDATAHL ICHL Control Mix Icon Value –
High byte, Low nibble

ICONDATALH ICLH Control Mix Icon Value –
Low byte, High nibble

ICONDATALL ICLL Control Mix Icon Value –
Low byte, Low nibble

ICON28HH IC28HH High 7 bit nibble of a 28 bit
word
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ICON28HL IC28HL Next highest 7 bit nibble of
a 28 bit word

ICON28LH IC28LH Next lowest 7 bit nibble of
28 bit word

ICON28LL IC28LL Least significant 7 bit
nibble of 28 bit word

PARAMDATA PR Control Parameter Value
PARAMDATAH PRH Control Parameter Value –

High byte
PARAMDATAL PRL Control Parameter Value –

Low byte
PARAMDATA14H PR14H Control Parameter Value –

High <7bits>
PARAMDATA14L PR14L Control Parameter Value –

Low <7bits>
PARAMDATAHH PRHH Control Parameter Value –

High byte, High nibble
PARAMDATAHL PRHL Control Parameter Value –

High byte, Low nibble
PARAMDATALH PRLH Control Parameter Value –

Low byte, High nibble
PARAMDATALL PRLL Control Parameter Value –

Low byte, Low nibble
PROGRAM PG Control Program Value
PROGRAMH PGH Control Program Value –

High byte
PROGRAML PGL Control Program Value –

Low byte
PROGRAM14H PG14H Control Program Value –

High <7bits>
PROGRAM14L PG14L Control Program Value –

Low <7bits>
PROGRAMHH PGHH Control Program Value –

High byte, High nibble
PROGRAMHL PGHL Control Program Value –

High byte. Low nibble
PROGRAMLH PGLH Control Program Value –

Low byte, High nibble
PROGRAMLL PGLL Control Program Value –

Low byte, Low nibble
ICONRADIUS RD Mix Icon Radius

0==rim 127==center
ICONTHETA TH Mix Icon Theta

theta 0==left 127==right
ICONX PX Mix Icon X absolute value
ICONY PY Mix Icon Y absolute value
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VSL Arithmetic Computation

A Data Value can be the result of a computation, combining constants and variables to
calculate a single data value.  A Computed Data Value is an open parenthesis followed by
an algebraic expression followed by a close parenthesis. Parenthesis can be nested.

The following table gives the algebraic operators and their meaning and precedence.

Symbol Precedence Meaning
( 0 Start of a computation.
) 0 End of a computation.
NOT 1 Unary bitwise NOT

operator
- 1 Unary minus when attached

to data.
* 2 multiply
/ 2 divide
% 2 modulo
+ 3 add
- 3 subtract
<< 4 left shift
>> 4 right shift
AND 5 bitwise AND
XOR 6 bitwise EXCLUSIVE OR.
OR 7 bitwise OR

Computation expressions are parsed in order of precedence, with left to right evaluation
of operators at the same precedence level.  The above precedence levels and parsing
description are almost identical to those used in the C language.

An example of a computation is:
 ((3 + IX * 4) << 2)

If a computation contains an Icon Coordinate (IC…, RD, TH, PX, PY), it is a dynamic
computation and will not be used to compare against a received MIDI message.
However, if it doesn’t contain an Icon Coordinate, it is a static computation, and will be
used to match against an incoming MIDI message. Static computations can contain any
other register values, for example, Program, <PG…>,Parameter <PR…>, Index <IX…>,
etc.
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VSL Control Commands
There are two commands which determine when and how the assembled control message
is sent. These are SENDNOW, and DELAY.

SENDNOW ,  <SN>, causes the message to be sent at this point in the message sequence.
This command can be used to sequence multiple messages in a single control sequence if
necessary.

DELAY,  <DE>, causes the message to be queued and then sent after delaying a certain
number of milliseconds. This token requires a subsequent value that sets the number of
milliseconds to be delayed in 5mSec increments.  The delay actually set is 5 * (the delay
value) mSec. Currently, SYSEX messages are not queued.

Example:
sounds:Low-Boing
!  Program number is set in 'Parameter' (127 max).
!  Note No. in 'Theta', attack in 'Radius'.
!  Note Off delay is set in 'Program'
PN HC MC PB PR SN                 #program change (in parameter)
PN H9 MC PB TH RD SN           #note on (in Theta) attack (in Radius)
PN H8 MC PB TH PG DE PG;    #note off (in Theta) with delay (in program)

sounds:High-Boing
!  Program number is set in 'X'
!  Note number is set from (127-Theta), Attack is 'Radius'
!  Note off aftertouch in 'Program', Delay in Y
MIN  0
MAX 127
PC MIDI
PN HC MC PB PX SN                            #program change (in X)
PN H9 MC PB (127+ -TH) RD SN         #note on  (in 127 - Theta) attack (in Radius)
PN H8 MC PB (127+ -TH) PG DE PY;  #note off (in 127 - Theta) with delay (in Y)

This example shows two VSL controls in the component ‘sounds’. Each control consists
of 3 separate MIDI commands that set the sound ‘voice’ (Program Change), the NoteOn
command, and a delayed NoteOff command which sets the note duration of ‘delay’.

VSL Advanced Topics
The VSL language, as initially specified, is essentially a string ‘construction’ language,
and each received string is matched against all active controls’ ‘send’ strings. Each match
causes the Mix Icon attached to that control to respond appropriately.

The MIDI protocol, especially as it pertains to messaging to hardware other than music
synthesizers, has undergone considerable development over recent years. However, some
of the ‘new’ MIDI protocols require that the received string be further processed to find a



150

match, e.g. the string that is sent to a particular control by GraphiMix may not exactly
match the string that is received back from the same control. This complicates the
creation of the VSL specifications for these protocols, essentially requiring the author of
the VSL to identify the exact protocols that apply and marking where they can appear in
the received strings.

These features require special commands, called Pseudo-Ops, to be inserted at specific
places in the VSL language sequence for a particular control. These VSL pseudo-ops are
described below.

Control Change Protocol Pseudo-Ops
The Control Change message (starting with hexadecimal ‘B’) has been extended to allow
for a larger number of addressable controllers, and for greater controller data precision to
14 bits. Some components of the specification for a single control can be defaulted, i.e.
not sent every time.

Parameters controllers are a subset of the control change message group, and they are
divided into the registered and non-registered numbers (RPN and NRPNs). RPNs are
intended to apply universally, and to be registered with the MIDI Manufacturers’
Association (MMA), while NRPNs may be manufacturer specific.

Parameter controllers operate by specifying the address of the parameter to be modified,
followed by a control change message to set the value or to increment or decrement the
current value. The address of the parameter can be set in two stages, with an MSbyte and
then an LSbyte message, so as to allow for up to 16384 possible parameter addresses.
The controller numbers (hex)62 and (hex)63 are used to set the LS and MSbytes (7 bit
values) respectively of an NRPN, while (hex)64 and (hex)65 are used to address RPN’s.

The sequence of messages required to address and change a parameter is as follows:
Message 1
(hex) [Bn] [62 or 64] [LSB]
Message 2
(hex) [Bn] [63 or 65] [MSB]
Message 3
(hex) [Bn] [60 or 61] [7F] – or – [Bn] [06] [MSBData] [Bn] [26] [LSBData]

Message 3 represents either data increment [(hex)60] or data decrement [(hex)61], or a 14
bit data entry slider control change with MSbyte ((hex)06) and LSbyte ((hex)26) parts. If
the control has not moved very far, it is possible that only the MSbyte message need be
sent. In that case, the MSbyte message would be defaulted.

Not all MIDI protocols in use adhere to the section above. Sometimes only the LSbyte of
an NRPN is sent, sometimes only the MSbyte. Sometimes these RPN or NRPN
parameters are defaulted, that is, if the MIDI traffic is high, the console may not send this
part of the message every time.
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As for data, sometimes only 7 bit data is sent, sometimes 14 bits of data are sent, and
sometimes one of the two messages for the 14 bit data is defaulted, including the last
message sent.

Some manufacturers ignore the above multi-byte protocol and use all available controller
numbers as 7 bit controllers.  Some manufacturers specify conflicting protocols for
different console models.

To address these issues, the GraphiMix VSL language includes a series of CC (control
change) pseudo-ops. These are inserted in the VSL specification just before specifying an
RPN or default-able Control Change (CC) data type message.

These are:
CC_RPN An RPN or NRPN parameter (must be sent

every time)
CC_RPN_DEFAULT The following 3 byte control change

message is an RPN or NRPN Ms or Lsbyte
and can be defaulted (not sent every
message if it doesn't change)

CC_INCREMENTAL The following 3 byte message is an
INCR/DECR message

CC_14BIT_MSB The following 3 byte message is the MS (7
bits) of a 14 bit continuous controller value

CC_14BIT_MSB_DEFAULT The following 3 byte message is the MS (7
bits) of a 14 bit continuous controller value
and can be defaulted

CC_14BIT_LSB The following 3 byte message is the LS (7
bits) of a 14 bit continuous controller value

CC_14BIT_LSB_DEFAULT The following 3 byte message is the LS (7
bits) of a 14 bit continuous controller value
and can be defaulted

For example, here is the VSL description for a 12 byte CC message, consisting of 4
individual CC messages. The NRPN MSB is defaulted and the LSbyte of the 14 bit data
is also defaulted.

Component:12ByteControl #control name

MIN 0 #min value of control
MAX 16383 #max value of control
PC MIDI #MIDI protocol
CC_RPN #The following CC message is a

# required (N)RPN message
PN HB MC # (hex) B for CC, Midi channel goes



152

# in second nibble
# PN stands for ‘PushNibble’

PB H62 #Specify a NRPN LSByte
# PB stands for ‘PushByte’

H12 #The LSByte value for this control
CC_RPN_DEFAULT #The following CC message is a

# defaulted (N)RPN message
PN HB MC # (hex) B for CC, Midi channel goes

# in second nibble
PB H63 #Specify a NRPN MSByte

H34 #The MSByte value for this control

CC_14BIT_MSB #The following CC message is a
# required 14 bit data value MSByte

PN HB MC # (hex) B for CC, Midi channel goes
# in second nibble

PB H06 #Specify a 7 bit controller

IC14H #upper 7 bits of 14 bit data

CC_14BIT_LSB_DEFAULT #The following CC message is a
# defaulted 14 bit data value LSByte

PN HB MC # (hex) B for CC, Midi channel goes
# in second nibble

PB H26 #Controller’s low order 7 bits of a
#14 bit value

 IC14L #lower 7 bits of 14 bit data

SN ; #end of VSL spec

Here is the description of a 6 byte message consisting of 2 CC messages. The first is an
NRPN LSByte message which can be defaulted, followed by a 7 bit controller data
message. Note that no pseudo-op is required for 7 bit data CC messages.

Component:6ByteControl #control name

MIN 0 #min value of control
MAX 127 #max value of control
PC MIDI #MIDI protocol
CC_RPN_DEFAULT #The following CC message is a

# defaulted (N)RPN message
PN HB MC # (hex) B for CC, Midi channel goes

# in second nibble
PB H62 #Specify a NRPN LSByte
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H01 #The LSByte value for this control

PN HB MC # (hex) B for CC, Midi channel goes
# in second nibble

PB H06 #Specify a 7 bit controller

IC # 7 bit data

SN ; #end of VSL spec

Here is an example of a six byte incremental control.

Component:IncrmntlControl #control name

MIN 0 #min value of control
MAX 127 #max value of control
PC MIDI #MIDI protocol

#The following CC message is a
# required message

PN HB MC # (hex) B for CC, Midi channel goes
# in second nibble

PB H62 #Specify a NRPN LSByte

H01 #The LSByte value for this control

CC_INCREMENTAL #The next message will match for
# INCR or DECR

PN HB MC # (hex) B for CC, Midi channel goes
# in second nibble

PB H60 #Specify incremental data CC

H7F # don’t care data

SN ; #end of VSL spec

Signed Data Pseudo-Op

Some manufacturers occasionally use signed data in their message protocols. This data
format uses the most significant bit as a sign bit generating the following sequences:

Signed (hex) Decimal
40 -64
7F -1
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0 0
3F 63

Most MIDI control change messages use unsigned data.

Unsigned (hex) Decimal
0 0
3F 63
40 64
7F 127

Note, that as a GraphiMix control is moved from MIN to MAX, the sequence of signed
data values jump from 7F to 0 as the values transition from -1 to 0, in the middle of the
movement.

Here is an example of signed data used in a Control Change VSL.

Component:SignedControl #control name

MIN -64 #min value of control
MAX 63 #max value of control
PC MIDI #MIDI protocol
SIGNED #Specify signed data
PN HB MC # (hex) B for CC, Midi channel goes

# in second nibble
PB H62 #Specify a NRPN LSByte

H01 #The LSByte value for this control

PN HB MC # (hex) B for CC, Midi channel goes
# in second nibble

PB H06 #Specify a 7 bit controller

IC # 7 bit signed data

SN ; #end of VSL spec

Here is an example of signed data used in a SYSEX VSL.

Component:SignedControl #control name

MIN -8192 #min value of control
MAX 8191 #max value of control
PC MIDI #MIDI protocol
SIGNED #Specify signed data
PB HF0 # Start Sysex
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H00 #3 byte manu ID

H01 #

H42 #
H12 # Parameter number
IC14H # 14 bit signed data

# MS 7 bits
IC14L # LS 7 bits
HF7 #End of Sysex

SN ; #end of VSL spec

Here is an example of a SIGNED pseudo-op in combination with the
CC_INCREMENTAL pseudo-op to support, for example, a JLCooper CS10 Wheel
control.

CS10:Wheel # control name
SIGNED
PC MIDI
MIN -64
MAX 63
CC_INCREMENTAL
PN HB # push nibble hex B =

Control Change
HF # midi channel 16

 PB H60 # Pan
IC # value

SN; # end of VSL

Sysex Templates for Variable Length messages
System exclusive messages have also gotten more complex with variable-length
protocols that allow a single message to specify two or more controls at a time.  These
messages have 2 components, a sequence of one or more bytes that specify a parameter
number (specifying which control the message is for) and a sequence of one or more
bytes that specify the parameter value (specifying what value to set that control to).

If two adjacent controls are being adjusted at the same time (for example two side-by-
side faders), and they are adjacent in SYSEX parameter numbers, then a single SYSEX
message is generated, where the data for the second control is added at the end of the
message. The parameter number is essentially being auto-incremented (to the next
control), and the data to be substituted for the second control is added at the end. This can
extend for many controls if the many controls are being adjusted together.
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In order for GraphiMix to respond correctly to these messages, a SYSEX template VSL,
must be created that describes how to correctly interpret these variable length messages.
There is just one of these template VSLs for each form of variable length SYSEX
message.

This template VSL must have the component name “sysex_template”. Any VSL that is a
member of this component is put on a special list and is compared to incoming MIDI
SYSEX messages to see if it is a variable length message. If there is a match, GraphiMix
creates multiple, separate messages, one for each parameter being addressed, and then
does its normal input MIDI message processing on each. Normally, this VSL template
would be in the VSL file that contains the controls that use that form of the SYSEX
variable length message. It is not necessary to attach this VSL to a Mix Icon, but it is
necessary that the template VSL reside in the same VSL file as the relevant SYSEX
VSLs (that are attached to icons) in order to insure that it is loaded into GraphiMix.

The parameter number part of the template VSL specification must be marked with
pseudo-ops that specify the exact sequence of bytes that contains the parameter number
to be auto-incremented. The beginning is marked with “AUTO” and the end of the
sequence is marked with “AUTOEND”.

The data to be substituted with extra bytes at the end of the message must also be marked
with "SUBS" and "SUBSEND”.

Here is an example of a variable length SYSEX VSL.

sysex_template:VSLtemplate #component is sysex_template
#control name

MIN 0 #min value of control
MAX 65535 #max value of control
PC MIDI #MIDI protocol
PB HF0 # Start Sysex

H00 #3 byte manu ID

H01 #

H42 #
AUTO # Begin Auto-Incremented param num

H00 # Parameter number (high byte)
H00 # Parameter number (low byte)

AUTOEND # End Auto-Incremented param num
SUBS # Begin substituted data area

ICHH # 16 bit data
# MS 4 bits

ICHL # next 4 bits
ICLH # next 4 bits
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ICLL # LS 4 bits
SUBSEND # End substituted data area

HF7 #End of Sysex
SN ; #end of VSL spec

Two adjacent controls that use the above form of SYSEX message, would respond to the
string: (hex) “F0 00 01 42 12 34 05 0C 0E 02 04 0E 05 01 F7”.

 The first control at parameter number (hex)1234 would get data (hex)5CE2, the second
control at parameter number (hex)1235 would get data (hex)4E51.

VSL Formal Syntax Description
 Formal Syntax Description:

 The following paragraph is a precise definition of the command syntax.
 Please read it very carefully. It is precise and very dense.
 It is essentially stated in Backus Naur Form (BNF) without using the Backus Naur
formalism.

 At the top level, the syntax is any number of CONTROLS where CONTROL
 is either a CONTROL_NAME or a COMPONENT_NAME followed by ':' followed by
CONTROL_NAME.

 The control is followed by any number of  COMMANDS, followed by a semicolon.

 A COMMAND is a COMMAND_TYPE followed by zero or one DATA_ELEMENTS.

 A DATA_ELEMENT is a number or a number preceded by an H (for hex data)
 or a COMPUTATION.

A COMPUTATION is a an Open Parenthesis '(' followed
 by CALCULATION_OPERATION, terminated by a close parenthesis ')'.

 A CALCULATION_OPERATION is one of the calculation operations given below
 along with optional one word of data.

 Here is the description using BNF. I use only the shortened form of the command names.
 Note that because of the 'sticky' PushData commands above, a BNF description is not
 completely adequate.

 White space character  is a space or a tab.
 <WSC>   ::= ' ' | 'tab'

 White space is any sequence of white space characters.
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 <WS>    ::= <WSC>*

 A VSL is any number of controls
 <VSL>   ::= <CONTROL> *

 A control name is either a full control name or a partial control name.
 <CONTROL_NAME> ::= <FULL_CONTROL_NAME> |
<PARTIAL_CONTROL_NAME>

 A partial control name is any sequence of alphabetic characters.
 <PARTIAL_CONTROL_NAME> ::= <a-z>*     // Any number of characters.

 A component name is any sequence of alphabetic characters.
 <COMPONENT_NAME> ::= <a-z>*     // Any number of characters.

 A full control name is a component name followed by a : followed by
 a partial control name.
 <FULL_CONTROL_NAME> :== <COMPONENT_NAME> ':'
<PARTIAL_CONTROL_NAME>
 A control is optional white space followed by a control name followed
 by any number of commands followed by optional white space followed by a semicolon.
 <CONTROL> ::= [WS] <CONTROL_NAME>  <WS><COMMAND>[WS] *  ';'

 A command is either a no data command or a command that takes one piece of data
 or a set once command.
 <COMMAND>    ::=  <NO_DATA_COMMAND> | <CC_PSEUDO_OP> |

<SIGNED_PSEUDO_OP> |
<SYSEX_TEMPLATE_PSEUDO_OP > |
<ONE_DATA_COMMAND> |

                                    <SET_ONCE_COMMAND>

 A no data command is one of the following:
<NO_DATA_COMMAND> ::=  'SN'

A Control Change Pseudo-Op is one of the following:
<CC_PSEUDO_OP>::=’ CC_RPN’ | ‘CC_RPN_DEFAULT’ | ‘CC_INCREMENTAL’ |

   ‘CC_14BIT_MSB’ | ‘CC_14BIT_MSB_DEFAULT’ |
   ‘CC_14BIT_LSB’ | ‘CC_14BIT_LSB_DEFAULT’

A Signed Data Pseudo-Op is one of the following:
<SIGNED_PSEUDO_OP> ::= ‘SIGNED’

A System Exclusive Template Pseudo-Op is one of the following:
<SYSEX_TEMPLATE_PSEUDO_OP >::= ‘AUTO’ | ‘AUTOEND’ | ‘SUBS’ |

           ‘SUBSEND’
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 A one data comand is PN, PB, or PW or DE followed by a data element.
 <ONE_DATA_COMMAND>  ::= [WS] 'PN’ | ‘PB’ | 'PW' | 'DE' <DATA_ELEMENT>

 A set once command is a MIN or a MAX followed by a numeric data field..
 <SET_ONCE_COMMAND> ::= 'MIN'  |  'MAX '<NUMERIC_DATA>

 A numeric data field is a single integer in decimal or a hex number preceded by an H.
<NUMERIC_DATA> ::= <decimalnumber.> | 'H' <hexnumber>

 A data element is a number of H followed by a number or MC, or MX, or MI or MI2
 or a COMPUTATION.
<DATA_ELEMENT>  ::= <decimalnumber> | 'H'<hexnumber> |
                   'MC' | 'IX' |  'IC' |  ‘PR’ | ‘PG’ | … |   <COMPUTATION>

A computation is an open parenthesis followed an algebraic expression followed
 by a close parenthesis.
 <COMPUTATION >  ::= [WS] '('{WS] < ALGEBRAIC_EXPRESSION>[WS] ')'

Computation expressions are parsed in order of precedence, with left to right
 evaluation of operators at the same precedence level.
 The above precedence levels and parsing description are almost
 identical to those used in the C language.

 Example: An example of a computation is:
 ((3 + IX * 4) << 2)

GraphiMix Internal Variables and Commands

Description of internal commands.

The complex Data Types are used to create Stereo and Surround mixes by operating on
input-by-output fader matrix configurations. An example of this configuration would be a
setup where each input channel is connected to an output bus by way of a single fader. If
there were four output busses, each input would have four faders, one for each output
bus.

For a simple example, a standard single input channel fader followed by a stereo panpot
configuration could be simulated by the appropriate settings of two faders which are
connected between the input channel and each of the two stereo output channels.

A 5 channel surround system would send appropriate settings to the 5 faders for each
input channel.

The ‘appropriate settings’ are represented by equations that combine ‘internal constants’
with the current Mix Icon coordinates to arrive at a value that is sent to some physical
control.
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The equations are shown below. The ‘internal constants’ can be set and stored in up to 10
different ‘banks’, to provide different ‘multi-channel positional fader behaviors’. Each
bank can be referenced individually by each Mix Icon Control with the setting in the
Index field. These internal constants can be modified by using control VSLs included in
VygrInternal.VSL with the protocol set to ‘INTERNAL’.

An Excel spreadsheet, GraphiMixFaderPlots.xls, is included with the release to help the
engineer determine the appropriate settings for these internal constants.

With future releases, Voyager Sound intends on providing multiple, different sets of
equations for Stereo and Surround positional behaviors including a way for the user to
add custom functions.

Stereo Fader algorithm.

One example of the use of these ‘positional fader behaviors’ would be to vary the stereo
panpot convergence or the surround panner characteristics setting with the individual
sound source.
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To set the bank number for these variables when setting their values, use the
SetCurrentBankInternal control as the first control in the Mix Icon Properties Controls
Tab. Here we set the bank to 1.
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Follow with the setting for this particular bank. We set the Separation Power to 32 which
represents a ‘0.5’ in the equation for this variable.
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Notice that the Index field is set to 1 for the left and right controls in the following Mix
Icon Controls setup to use Parameter Bank 1 for this particular set of pan-fader
characteristic curves. This uses two fader-type level controls on the target mixer to
simulate a fader-panpot combination with settable center convergence.
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Right
faderMult = 1.0 - (SeparationPower[bank] - 1.0) *(( MixIconTheta - 90) / 180)
fader = faderMult * MixIconRadius * (sin((90 + MixIconTheta) * 0.5F))
fader = min(fader, 1.0)
fader = max(fader, 0.0)
FaderVal = (MIN + (MAX – MIN)*Fader)

Left
faderMult = 1.0 - (SeparationPower[bank] - 1.0) *(( - 90 - MixIconTheta) / 180);
fader = faderMult * MixIconRadius * (sin((90 - MixIconTheta) * 0.5F));
fader = min(fader, 1.0)
fader = max(fader, 0.0)
FaderVal = (MIN + (MAX – MIN)*Fader)

Example of fader characteristic curves with SeparationPower set to 0.5 (parameter value
32).
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PanFader DataTypes
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Example of fader settings with SeparationPower set to 1.0 (parameter value 64 – default
setting).
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Example of fader settings with SeparationPower set to 1.5 (parameter value 96).

PanFader DataTypes

0

0.2

0.4

0.6

0.8

1

1.2

-90 -82 -74 -66 -58 -50 -42 -34 -26 -18 -10 -2 6 14 22 30 38 46 54 62 70 78 86

Theta

Fa
de

r V
al

ue
s

Right Fader - Max Level

Right Fader - 75% Level

Right Fader - 50% Level

Right Fader - 25% Level

Lef t Fader - Max Level

Lef t Fader - 75% Level

Lef t Fader - 50% Level

Lef t Fader - 25% Level



166

Quad Fader algorithm.

Width = (WidthMult[bank] / pow(max( SeparationMin[bank], MixIconRadius ),
SeparationPower[bank] ) ) – WidthMult[bank] + WidthMin[bank]

ThetaDiff = abs(MixIconTheta - ChannelTheta[bank])

fader = (1.0 –MixIconRadius) * exp(-ThetaDiff/Width[bank])
fader = min(fader, 1.0)
fader = max(fader, 0.0)

FaderVal = (MIN + (MAX – MIN)* fader)

Set variable bank then set variables

Note that each QuadFader data types’ center theta can be set individually. With 5
QuadFader types and 10 banks, one could potentially have 50 discrete output channels,
each at a separate angle.

Initialized Values for ChannelTheta

LEFT_FRONT_THETA    -45.0F
RIGHT_FRONT_THETA   45.0F
LEFT_REAR_THETA     -135.0F
RIGHT_REAR_THETA    135.0F
CENTER_THETA                 0.0F

This chart shows the characteristic curves for four of the QuadFader data types. There are
5 total of these data types, the center one is not shown to minimize chart clutter. These
curves shows the settings when the Mix Icon is set for maximum volume, essentially
changing the panner setting only. Of course, as the radius of the Mix Icon is changed, the
volume level overall also changes, fading to zero at the mute radius. This provides a
dynamic surround effect where not only does the direction change as the pan angle is
changed, but the volume level also modulates with the loudest being the center of the mix
form, falling to mute at the mute radius.

This plot represents the default settings of Surround Fader data types.
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Surround Fader Simulation
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This chart represents the settings when the SeparationMin parameter is changed to 0.4.
Note that there is now more directionality and that the off-angle channels are more
attenuated, even at maximum output level..
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SeparationMin(0.01 .. 1.28) Default
Parameter Value To be used in
VygrInternal.VSL Default

0.4 0.05 39 4
SeparationPower(0..2)    

1 1 64 64
WidthMult(0..254)    

100 100 50 50
WidthMin(1 .. 128)    

30   30 29     29

This chart represents the characteristic curves when the WidthMult parameter is
decreased to 20.
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Here is an example of a Mix Icon control setup to set the Quad data type parameters
using the INTERNAL protocol. Note that if a setup Mix Icon is configured as shown and
is present on the Mix Form, then it will issue its configuration setup commands
automatically when the Mix Form gets the focus (becomes the selected Mix Form).



170

Here is an example of a Mix Icon setup using the Quad data types to set 4 individual
channels on a target console.
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VygrInternal.VSL

# VygrInternal.VSL
# Version: 1.0
# Copyright 2001 Voyager Sound Inc.
#
# VSL for VYGR internal controls
#
# Edit history
# KK  8:30Am 26-Nov-2001   creation   K. Krug
<Version>:Version
                 ! VygrInternal VSL <copyright> 2001 Voyager Sound Inc.All Rights Reserved
                 ! Version 1.0 11/26/01 Creation
                 ! PROTOCOL INTERNAL
                 ;

<Version>:Version
PC INTERNAL
                 ! VygrInternal VSL <copyright> 2001 Voyager Sound Inc.All Rights Reserved
                 ! Version 1.0 11/26/01 Creation
                 ! PROTOCOL INTERNAL
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                 ;

#
# Edit history
# KK  8:30 AM 11/26/01 Creation

ResetToFactorySettingsInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Reset to Factory Settings for all banks
PN HB MC PB 0 0 SN;

SetCurrentBankInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set current parameter bank to value set in 'Parameter' <0-9>
PN HB MC PB 1 PR SN;

SetLeftFrontThetaPrInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set Left Front channel angle to value set in 'Parameter' <0-127>
!   <0-127> => {-180 to +180}
PN HB MC PB 16 PR SN;

SetLeftFrontThetaInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set Left Front channel angle to value set in Mix Icon Coordinate
PN HB MC PB 16 IC SN;

SetRightFrontThetaPrInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set Right Front channel angle to value set in 'Parameter' <0-127>
!   <0-127> => {-180 to +180}
PN HB MC PB 17 PR SN;

SetRightFrontThetaInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set Right Front channel angle to value set in Mix Icon Coordinate
PN HB MC PB 17 IC SN;

SetLeftRearThetaPrInternal
PC INTERNAL
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! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set Left Rear channel angle to value set in 'Parameter' <0-127>
!   <0-127> => {-180 to +180}
PN HB MC PB 18 PR SN;

SetLeftRearThetaInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set Left Rear channel angle to value set in Mix Icon Coordinate
PN HB MC PB 18 IC SN;

SetRightRearThetaPrInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set Right Rear channel angle to value set in 'Parameter' <0-127>
!   <0-127> => {-180 to +180}
PN HB MC PB 19 PR SN;

SetRightRearThetaInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set Right Rear channel angle to value set in Mix Icon Coordinate
PN HB MC PB 19 IC SN;

SetCenterThetaPrInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set Center channel angle to value set in 'Parameter' <0-127>
!   <0-127> => {-180 to +180}
PN HB MC PB 20 PR SN;

SetCenterThetaInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set Center channel angle to value set in Mix Icon Coordinate
PN HB MC PB 20 IC SN;

#---

SetSeparationPowPrInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set Separation 'Power' to value set in 'Parameter' <0-127>
!   <0-127> => {0.0 to 2.0F}
PN HB MC PB 21 PR SN;
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SetSeparationPowInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set Separation 'Power' to value set in Mix Icon Coordinate
PN HB MC PB 21 IC SN;

SetWidthMultPrInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set WidthMult to value set in 'Parameter' <0-127>
!   <0-127> => {0.0 to 254.0} Nominal = 100.0
PN HB MC PB 22 PR SN;

SetWidthMultInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set WidthMult to value set in Mix Icon Coordinate
!   <0-127> => {0.0 to 254.0} Nominal = 100.0
PN HB MC PB 22 IC SN;

SetMinSeparationPrInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set MinSeparation to value set in 'Parameter' <0-127>
!   <0-127> => {0.01 to 1.28} Nominal = 0.05
PN HB MC PB 23 PR SN;

SetMinSeparationInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set MinSeparation to value set in Mix Icon Coordinate
!   <0-127> => {0.01 to 1.28} Nominal = 0.05
PN HB MC PB 23 IC SN;

SetWidthMinPrInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set MinSeparation to value set in 'Parameter' <0-127>
!   <0-127> => {1.0 to 128.0} Nominal = 30.0
PN HB MC PB 24 PR SN;

SetWidthMinInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set MinSeparation to value set in Mix Icon Coordinate
!   <0-127> => {1.0 to 128.0} Nominal = 30.0
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PN HB MC PB 24 IC SN;

SetWidthMaxPrInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set MaxSeparation to value set in 'Parameter' <0-127>
!   <0-127> => {500 to 3040} Nominal = 1000
PN HB MC PB 25 PR SN;

SetWidthMaxInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Set MaxSeparation to value set in Mix Icon Coordinate
!   <0-127> => {500 to 3040} Nominal = 1000
PN HB MC PB 25 IC SN;

# -- Generic control changes
ControlChangeInternal
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Parameter number is set in 'Parameter' <0-127>
!  Parameter value is set from Mix Icon 'Coordinate'.
PN HB MC PB PR IC SN;

ControlChangeInternalPG
PC INTERNAL
! MIDI INTERNAL Program Change message ---------------------------------------------------
!  Parameter number is set in 'Parameter'
!  Parameter value is set in 'Program' <0-127>.
PN HB MC PB PR PG SN;
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About This Manual
This manual is provided with the release and is available in the GraphiMix install
directory as GraphiMixReferenceManualShareware.pdf.  The GraphiMix Users Guide is
also available and is named GraphiMixUsersGuideShareware.pdf.

Contact Information
Due to this free shareware opportunity, support will be given to those who submit a
shareware fee of $25 (US) sent via  US post.  Please include your email address. You will
be sent a receipt.

To send us a postal letter, send it to:

Support
Voyager Sound Inc

P.O. Box 115
Weston, MA. 02493  U.S.A.

License Agreement
NOTICE
Copyright (c) 1993-2007 Voyager Sound, Inc.

Voyager Sound and GraphiMix are trademarks of Voyager Sound, Inc.

This software is licensed to you under the terms and conditions stated in the License
Agreement.  Use of this software constitutes your acceptance of the terms of the license

agreement.  Please read the license agreement carefully before using this program.

Unauthorized reproduction or distribution of any material or programming contents
contained in this software is prohibited.

LICENSE AGREEMENT
Do not use this software until you have carefully read the following Agreement.  This
Agreement sets forth the terms and conditions for licensing of the software from Voyager
Sound, Inc. to you (“you” or “Licensor”), and using the software indicates that you have
read and understand this Agreement and accept its terms and conditions.  If you do not
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agree with the terms and conditions of this Agreement, promptly return the software to
Voyager Sound, Inc.

This program is protected under United States copyright laws and trade secret laws.

“Software” is defined as (1) the Voyager Sound, Inc. computer program with which this
License Agreement is included; and (2) any third party content accessible through the
software (“Content”).

License Grant
You are granted a limited non-exclusive license to use a copy of the Software on one (1)
computer.  You may make one backup copy of the Software for your own use.  Making
additional copies or duplicating the software by any other means including electronic
transmission is illegal.  It is also prohibited to give copies to another person.  You may
not copy the printed materials if any, accompanying the Software, or print copies of any
user documentation.  The Software also contains proprietary information and the trade
secrets of Voyager Sound, Inc. and third parties, and you may not de-compile, reverse
engineer, disassemble, or otherwise reduce the software to human-perceivable form or
disclose such trade secrets or proprietary information.  You may not modify, adapt,
translate, rent, sublicense, assign, loan, resell for profit, distribute, or network the
software, diskette(s), or related materials or create derivative works based upon the
Software or any part thereof.  You may transfer your rights in the Software to a third
party, or sell the computer on which the software is installed to a third party, provided
you do not keep a copy of the Software for yourself.  Voyager Sound, Inc. shall have the
right to change or add to the terms of the license at any time and to change, discontinue
or impose conditions on any aspect of the Software.  Such changes shall be effective
upon notification by any means reasonable to give you actual or constructive notice.

Disclaimer of Warranties

Except as provided above, this software, content, and/or any related services are provided
“as-is,” and to the maximum extent permitted by applicable law, Voyager Sound, Inc.
and its subsidiaries, affiliates, licensors, participating financial institutions, third-party
content providers, distributors, dealers or suppliers (“representatives”) disclaim all other
representations and warranties, express or implied, regarding this software, diskette(s),
related materials and any services, including their fitness for a  particular purpose, their
quality, their merchantability, or their non-infringement.  Voyager Sound, Inc. does not
warrant that the software is free from bugs, viruses, errors, or other program limitations,
including but not limited to accurate or updated third-party content.

Limitation of Liability and Damages
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The entire liability of Voyager Sound, Inc. for any reason shall be limited to the amount
paid by the customer for the software licensed from Voyager Sound, Inc. to the maximum
extent permitted by applicable law, Voyager Sound, Inc. and its  representatives are not
liable for any indirect, special, incidental, consequential, or other damages.



179

Patents and Copyrights
Voyager Mix GraphiMix® Copyright © 1993 - 2007 by Voyager Sound, Inc.
All rights reserved.
Applicable patent laws for the US and Europe applies.

Voyager Sound has US & Foreign Patents which protect this intellectual property.
U.S. Patent 5,212,733
Foreign Patent  0517848

All Voyager screens, literature and graphic material are Copyrighted, ©1993-2007
Voyager Sound Inc. of Weston Massachusetts.

Please contact Voyager for expanded license info.
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Glossary and Definitions
ACTIVE REGION The area of the Mix Form between the Mix Form

Origin and the 100% Radius coordinate (on a Stereo
Mix Form) or the +/- 100% X and Y coordinates. The
area outside the Active Region has the Radius
Coordinate set at 100%. The X and Y coordinates are
similarly ‘pinned’ at their maximum and minimum
settings.

BMP An abbreviation for a Windows Bitmap File.

BUILD MODE This is a mode of GraphiMix that allows the user to
‘build’ his mix surface, change Icon and Mix Form
properties and otherwise change the look, feel, or
function of his GraphiMix session. When in ‘Build’
mode extra menu entries are added to Mix Icon and
Mix From context menus to facilitate these actions.
GraphiMix can be either in ‘Build’ mode or in ‘Run’
mode.

CHANNEL A single input to an audio console. Also, in MIDI, a
number between 1 and 16 that specifies the MIDI
channel for the communication.

CLICK A press of a mouse button.

CLIPBOARD A Windows feature. The user can ‘cut’ or ‘copy’ to the
clipboard, then possibly select a different window or
application, and finally ‘paste’ the clipboard object on
to the destination.

CONSTRAINT Mix Icon movement on the Mix Form can be limited
in certain ways. For example, the Mix Icon can be
allowed to move up and down only and not side-to-
side. In this case the movement constraint would be
‘ConstantX’, it can only change the Y coordinate. The
‘Fixed Position’ constraint does not allow the Mix
Icon to move at all.

CONTROL A control is usually a piece of hardware that allows
the user to manipulate some parameter of the audio
production. A volume control or fader that receives
input from a source of audio and outputs to a single
bus would be an example of a control. Any
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mechanism that allows the user to manipulate some
parameter of an audio mix would be a control.

CONTROL RECIPE A specification or ‘recipe’ that describes how a control
can be communicated with. It effectively describes the
message protocol to a particular control. These
message protocols are designed by the companies that
manufacture the hardware or software. Most of the
time, these protocols are described in the equipment
manuals.
The Control Recipe describes how to construct a
particular message, using the GraphiMix™ VSL
language These recipes usually include constants that
indicate which control is being addressed, and over
what channel, as well as numbers that indicate the
setting to be applied.

CONTROL-KEY The Control Key on the PC keyboard is usually
located at the lower left and right bottom corners. A
Control-Key command involves holding the Control
Key down while pressing another key or clicking the
mouse.

DIALOG A Dialog is a Menu screen put up by GraphiMix™ to
allow the user to set and select various parameters. A
Dialog Box is a single entry on a Dialog menu screen.

DOUBLE-CLICK Two rapid mouse clicks in sequence. The threshold
that defines the difference between two single clicks
and a double click can be set using the Windows
operating system.

DOWNLOAD When the user is connected to the Internet, he can
browse to web sites which enable him to copy files
from a remote computer to his own, local computer.
This process is referred to as a download.

EFFECTS Controls which modify the sound and add filtering and
reverberation are called audio effects.

EMAIL Electronic mail that can be sent from the users
computer to other computers by using the Internet.

EQ EQ is short for Equalization. Equalization usually
means modifying the audio work by filtering and not
by adding effects, such as reverberation.



203

EVENT When a Mix Icon changes state, either by moving its
position or changing its internal states such as a switch
changing from On to Off, an event is generated. This
event usually results in a message being sent to all of
the Controls which are attached to the selected Mix
Icon if the event represents a change to the particular
control.

EXECUTABLE An executable is a file with the filename extension
‘.EXE’. These files usually represent programs and
applications that are ‘run’ by the user.

FADER A fader usually refers to a type of volume control that
slides up and down (or side to side) in a linear fashion.
A ‘knob’ would be a volume control that works in a
rotary fashion.

FEEDBACK LOOP A feedback loop is created when an output of a system
is fed back into the input. An example would be when
a microphone on stage gets too close to the speaker
which usually results in a loud squeal.
With MIDI, it is possible to hook a MIDI input to the
same MIDI output which can result in erroneous
operation. MIDI Yoke™ includes a mechanism to
detect MIDI feedback and will disable its port if it is
detected.

FIELD A field usually holds a number or a character string. In
dialog menus, there are usually fields that hold an
individual selection of a number or a name which can
be changed by the user.

FONT A font selects the ‘style’ of alphanumeric character
text. ‘Times New Roman’ and ‘Arial’ are examples of
font names.

GLASS CONSOLE A ‘Glass console’ is a software application that
provides control of a hardware or software audio
console by representing the individual controls as a
simulation of a hardware console. The on-screen
adjustments are made by adjusting graphic faders,
switches, and knobs with the mouse.

GRAPHIC MIX The Voyager Sound Graphic Mix is a new and unique
way to control hardware and software consoles using
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Mix Icon graphics placed on multiple Mix Forms.
Each Mix Icon changes the settings of several attached
controls with a single movement, greatly multiplying
the ability of the sound mix engineer to interactively
control the mix on a computer screen.

GRAPHIC USER INTERFACE A Graphic User Interface is a system of on-screen
displays and mouse and keyboard interactions that
provide a way for the user to specify actions to the
computer. An example of a Graphic User Interface
(abbreviated as GUI) is the Windows Operating
System.

HARDWARE CONTROL A hardware control is usually a piece of electronics
that processes and modifies audio signals in a way that
can be changed according to the engineer’s
requirements. A hardware control can be as simple as
a knob or fader potentiometer, physically moved by
the engineer, or as complex as a software algorithm
encoded into a digital audio processing device.

KNOB A knob is a rotary device that changes one or more
mix parameters.

LICENSE NUMBER The Voyager Sound GraphiMix™ requires four fields
of information to enable all its features. The License
Number is created by Voyager Sound based on the
other three registration fields for each licensed user.

LINK A link is a connection from a ‘Master’ Mix Icon to
one or more ‘Slave’ Mix Icons. The position of the
Slave Mix Icons is controlled by the position of the
Master Mix Icons and by the linking rules that
determine what the positional relationship is. Various
linking rules can be specified by the user.

MENU A Menu is a page that ‘drops’ down or otherwise
appears to allow the user to select various options or
parameters from a ‘menu’ of options or parameters.

MIDI The Musical Instrument Digital Interface (MIDI) was
invented in the early 1980’s by a group of synthesizer
manufacturers as a way to connect instruments
together to make sound. Since then it has evolved into
the protocol of choice for controlling everything from
sound synthesizers to tape machines.
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MIDI is a communications protocol consisting of
messages that consist of as few as 1 byte and up to
thousands of bytes.

MIDI INPUT A device or application that can receive and act upon
MIDI messages must have its MIDI Input source
selected.

MIDI OUTPUT A device or application that can send MIDI messages
to other devices or applications must have the
appropriate MIDI Output device specified.

MIDI PORT A MIDI port is a hardware or software device that
sends and receives MIDI messages to external
hardware or other software applications.

MIDI SEQUENCER A MIDI sequencer is like a ‘tape recorder’ for MIDI.
It receives and stores sequences of MIDI messages
and can then ‘Play them back’. Some sequencers allow
the engineer to modify the stored sequences and add
more sequences to different tracks to allow the
engineer to build up large multi-track compositions.

MIDI THRU Some MIDI devices can receive MIDI messages from
other devices and then ‘pass them on’ to its MIDI
output, mixed with its own MIDI messages. This
mode of operation is known as ‘MIDI Thru’ mode.

MIDI YOKE™ MIDI Yoke™ is a set of software drivers that create
software MIDI ports. These ports can be used to ‘plug
together’ software MIDI applications. For example,
one application can output to a MIDI Yoke™ port and
a different application on the same computer can
receive input from that same MIDI Yoke™ port,
effectively connecting the output of the first
application to the input of the second.

MIRROR When linking Mix Icons, the link rules can be set to
determine how the linked Icon’s movements are
controlled. A common linking rule is a ‘mirror’
operation where one of the coordinates would be
inverted around the Mix Origin, creating a ‘mirror’
effect, as if the Mix Icon were reflected around the
Mix Origin.

MIX CONSOLE A Mix Console is a device that usually controls
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multiple channels of audio inputs and outputs. The
audio on these inputs can have their volume and
filtering adjusted and effects added before being sent
to the outputs.
Mix Consoles are used by the audio engineer to create
final works of audio production such as records or
movies by manipulating the Mix Console controls to
achieve the desired effect.

MIX FORM A Mix Form is a window that has one or more Mix
Icons placed on it to control some piece of audio
hardware or software.
A stereo Mix Form represents a half plane where the
Mix Form Coordinates can range from +/- X to only
+Y. A Surround Sound Mix Form represents a full
plane where the Mix Form Coordinates range from +/-
X and +/- Y. The maximum values of the coordinates
are 100% and the minimums are 0 at the Mix Form
Origin.

MIX FORM COORDINATE A Mix Form Coordinate is one of Radius, Theta, X,
and Y. These coordinates are converted into control
commands by the placement of a Mix Icon and the
individual VSL control settings.

MIX FORM ORIGIN The Mix Form Origin is where the Radius, X and Y
have a value of 0%. For a Stereo Mix Form, the Mix
Form Origin is at the bottom center, for a Surround
Mix Form, the Mix Form Origin is in the center.

MIX FRAME The Mix Frame is the outermost window of a
GraphiMix™ mix session.

MIX ICON A Mix Icon is a graphic object that is placed on a Mix
Form to represent and control a collection of controls
that affect the Mix Parameters for a single source of
sound. For example, a single Mix Icon may control
both the volume and the pan position mixer controls
for a single channel.

MIX ICON STATE The Mix Icon State is represented by its coordinates
on the Mix Form as well as the setting of any internal
states that it may have. A switch-type Mix Icon, for
example, has two additional states, Switch On and
Switch Off, in addition to the coordinates of its
position on the Mix Form.
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MUTE BOUNDARY The Mute boundary is the circle that is at the 100%
Mix Form Radius coordinate. If a fader is attached to
the InverseRadius Mix Icon coordinate, then the value
of the attached fader will be 0 (muted) at this point. At
any point beyond this Mute Boundary, the fader will
remain muted. This area is the Mute Region.
For X/Y Mix Forms, the Mute Boundary is a square at
+/- 100% X and Y coordinates.

MUTE REGION The Mute Region is the area that is beyond the Mute
Boundary, depending on the Mix Form type. If the
Inverse coordinate function is used, this area can be
used to ‘park’ inactive or muted Mix Icons.

NON-LINEAR A Non-Linear function is a function where the output
changes in an abrupt manner and does not follow a
straight line.

PANPOT A Panpot control usually takes an audio signal and
distributes it between two or more output channels.
The relative distribution between the output channels
can be changed by setting the pan position
appropriately. For example, if the stereo pan position
control is in the middle, the signal is evenly divided
between the two output channels. If it is turned toward
the right, then more signal is sent to the right output
then to the left output.

PANPOT CONVERGENCE The Panpot Convergence refers to exactly how the
signal is distributed to the output channels as the
control is centered. Normally, signal power is
conserved, and if the control is centered, each output’s
level is -3dB down from the input (total output power
= total input power). In some situations, the user may
desire that both channels get boosted or cut from this
value. This change is made by adjusting the Panpot
convergence up or down.

PAR FILE The Yamaha DME32™ can output a file that
describes its custom configuration of mixer controls
and effects. This PAR file can be imported by the
GraphiMix02™ to create a custom VSL file which can
be used in a GraphiMix™ mix session.

PC SOUND CARD A personal computer that features sound capability
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(beyond keyboard beeps) contains a PC Sound card.
Most PC Sound cards can respond to MIDI commands
to create and modify sounds.

PIXEL A pixel is another name for a Picture Element, which
is a single, addressable ‘dot’ on a graphic display.

PROTOCOL A message Protocol is an instruction for how to
construct a message to be sent and received between
two communicating devices. MIDI and TCP/IP are
two examples of message protocols.

PURCHASE NUMBER The Voyager Sound GraphiMix™ requires four fields
of information to enable all its features. The Purchase
Number is issued by Voyager Sound based on the
product and the date of purchase.

QUAD One of several different types of Surround Sound.
Quad usually involves 4 separate speakers and 4
separate channels of sound.

RADIUS The Radius represents the Mix Icon’s distance from
the Mix Origin.

RADIUS BOUNDARY The Radius boundary is where the Mix Form Radius
Coordinate becomes 100%.

REBOOT Some software installations may require the user to
shut down Windows (using the Start->Shut down
menu in the desktop’s lower left corner) and restart.
This is termed a ‘reboot’.

REGISTRATION FIELD The Voyager Sound GraphiMix™ requires four fields
of information to enable all its features. These fields
are called ‘Registration Fields’. These can be accessed
under the ‘Help’ menu.

RESPONSIVENESS GraphiMix™ can ‘smooth out’ the mouse movement
by effectively averaging many mouse move events and
outputting the time average instead of the current
mouse position. This has the effect of giving the Mix
Icon a ‘smoother’ feel when adjusting its position with
the mouse.

REVERB Reverb is a type of effect that adds ‘echo’ to the audio
signal. Depending on the amount and kind of echos
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(reverb parameters) the effect can range from
simulating room acoustics to a setting that is an
intentional distortion to create a unique effect.

RS422 RS422 is a serial port hardware interface standard.
Message protocols may specify serial interface
standards such as RS232, RS422, or MIDI.

RUN MODE This is a mode of GraphiMix that limits the user to
‘running’ his mix surface. When in this mode,
GraphiMix inhibits the user from changing Icon and
Mix Form properties or otherwise changing the look,
feel, or function of his GraphiMix session. When in
‘Run’ mode, all extraneous menu entries are removed
from Mix Icon and Mix Form context menus that
aren’t needed during a mix. GraphiMix can be either
in ‘Build’ mode or in ‘Run’ mode.

RUNTIME ‘Runtime’ refers to when engineer is using
GraphiMix™ to actually perform the audio mix. This
is in contrast to when the engineer is designing the
mix session by creating Mix Icons and Mix Forms.

SCENE A GraphiMix™ scene contains one or more Mix
Session States.  Each state contains an entirely
separate copy of the Mix Session allowing for extreme
flexibility in defining Mix Session presets.

SOFTWARE METHOD A ‘Software Method’ defines a certain algorithm for
converting one kind of data value (such as a Mix Icon
Coordinate) to another (such as a control value).

SPLASH SCREEN The Splash Screen is the initial screen image that
comes up on the user’s monitor. The splash screen
contains the application manufacturers name and the
US and foreign patents that apply.

STATE A GraphiMix™ state contains an entirely separate
copy of a mix session. Each Mix Session State can
represent an entirely different arrangement for control
of the mix hardware.

STEREO A Stereo mix usually has at least two sets of output
channels, one labeled ‘Left’ and one ‘Right’.

SUB MIX A ‘Sub-Mix’ usually involves a subset of the available
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inputs that are mixed together separately before
entered into the ‘Main Mix’. An example would be a
situation where a drum set might have several
microphones placed to optimally record the bass drum,
the cymbals, the high-hat, and the toms. These
separate inputs might be mixed together with a ‘drum
sub-mix’ before the single or stereo output of this sub-
mix is entered into the ‘main mix’ with the rest of the
channels representing all the other instruments in the
session.

SURROUND A ‘Surround’ mix involves output channels that
represent a 360 degree sound field when played. An
example would be a multi-channel movie mix where
sound effects can come from behind and even from
within the audience. This can range from as few as 3
to a large number of output channels. The
GraphiMix™ provides several types of Surround Mix
Forms.

SWITCH A switch is a two state device consisting of an ON and
an OFF state. A multiple-pole switch is actually a
series of two state switches mechanically or
algorithmically linked together.

SYSEX MIDI SYStem EXclusive messages are abbreviated as
SYSEX and are a type of variable-length MIDI
message.

SYSTEM EXCLUSIVE MIDI System Exclusive messages are a message type
that begins with a <hexadecimal>F0 and ends with a
<hexadecimal>F7. This is the only MIDI message
type that is variable length. In practice, SYSEX
messages are used to signal everything from control
and program changes to bulk dumps and loads of the
entire hardware system state.

TAB BAR A Tab bar is a toolbar of tabs, each tab pulling up a
separate page, menu, or Mix System State.

TCP/IP This is a message protocol used over networks to
allow computers to access other computers and the
world wide web. It is an acronym that stands for
Transport Control Protocol-Internet Protocol.

TEMPLATE SESSION Creating a Mix Session from a blank Mix Form can be
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somewhat tedious if a large number of controls are to
be created. To speed this process somewhat, Voyager
Sound Inc provides several ‘template’ Mix session
files already set up to interface to several popular
digital mix consoles via MIDI. These ‘template’
session files can be copied, modified, and customized
to any degree. Individual Mix Icons with controls
attached can be copied, cut, and pasted to other Mix
Forms.

THETA A Mix Form and Mix Icon Coordinate. Front center is
0 degrees. Negative angles are on the left and positive
angles are on the right. When converted to a Mix Icon
control value, MIN is at the left extreme and MAX is
at the right extreme.

TOKEN A token in the VSL Control language is an individual
value or identifier, in a stream of such identifiers, that
represents a value or a computation in the output
message protocol specified in the VSL entry for a
particular control. For example, the MIDI channel
number, the address of the control in a control change
command, or the value sent to a mix console fader
control would all be represented as tokens in the VSL
file.

TOOL BAR A tool bar is a collection of icons that perform actions
within the GraphiMix™ application when clicked with
the mouse. A toolbar can be attached as a unit to the
Mix Frame or floated free as an independent window.

TOOL KIT GraphiMix™ includes a ‘kit’ of tools that help the
user construct and customize the Graphic User
Interface he uses to control the attached mixer
hardware.
The user can create his own Mix Icons and their
behaviors, decide how his hardware is to be controlled
by Mix Icon movement, and how many or how few
controls he wants on each Mix Form.
GraphiMix™ is really a toolkit of parts that can be
assembled in many unique and individual ways to suit
any engineer and any session requirements to create a
more effective way to control audio mix hardware.

TOP-DOWN A term that means from the most general description
progressing to the most detailed description.
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TRACK A Channel on a console.

TRACK STRIP A Channel on a console that includes all the controls
that are relevant to that channel.

UART An acronym that means Universal Asynchronous
Receiver Transmitter. A UART is a device that sends
and receives messages to external devices through a
variety of serial protocol interface standards.

VIRTUAL CONSOLE A Virtual Console is a representation of an audio mix
console on a computer screen.
A virtual console may appear as a graphic simulation
of a standard hardware console (a ‘Glass Console’) or
as a multi-dimensional Graphic User Interface (the
GraphiMix™).

VLB FILE The GraphiMix™ uses a file with the filename
extension ‘.VLB’ to hold each individual Mix Icon
Object and its image. Each Mix Icon that is shown in
the Mix Icon Selection Window and in the Mix Icon
Images properties tab is represented by a single VLB
file. An individual VLB may be used by more than
one Mix Icon at a time and on more than one Mix
Form.

VOY FILE A GraphiMix™ session is stored in a file with the
filename extension ‘.VOY’.

VSL FILE The control recipes that detail the message protocol
for a particular piece of controllable hardware is
contained in a file with the filename extension ‘.VSL’.
An individual user may create VSL files with up to 32
controls each.  Larger VSL files are available from
Voyager Sound Inc.

WEECON A tiny (‘wee’) icon can be attached to the corner of a
Mix Icon to add extra distinguishing marks to allow
the user to visually discriminate the selected Mix
Icons.

WORK SURFACE The term ‘Work Surface’ refers to the placement and
arrangement of the collection of controls arrayed on a
screen or on the surface of a mix console. The design
of the ‘work surface’ can help or hinder the engineer’s
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ability to create the audio work-in-progress.


